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Using This Guide
This user guide provides instructions for installing, operating and 
maintaining Eden 3‐D printing systems. It explains how to use features, 
and provides practical examples to guide you as you use the system.
The text and figures in this guide are based on the Eden500V 3‐D printer, 
printer software version 50.0.1.14 and Objet Studio software version 8.0.2.3.
This guide assumes that:
• all the hardware, software, and network components of your Eden 

system are installed, configured, and operating correctly.
• the operator has a working knowledge of the Windows® PC platform.

For More Information
Visit http://www.2objet.com/ for more details about Objet’s technology, 
products and consumables, and for service and support contacts.
For other documents that relate to Eden500V/Eden350V/Eden350 3‐D 
printing systems, and for this document in other languages, contact your 
regional Objet Customer Support office.
If you have any questions about the information presented in this 
document, or if you have any comments or suggestions for future editions, 
please send a message to support@2objet.com.

http://www.2objet.com/ 
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Terms Used in This Guide

build tray In Objet Studio: The surface displayed on the screen that 
represents the actual build tray in the Eden printer.
In the Eden printer: The surface upon which models are 
produced.

cleaning fluid Cleanser for flushing model feed tubes and the printing 
block, used to completely remove model material from the 
system before loading another type of material in the printer. 
The cleaning fluid is supplied in model‐material cartridges.

client/user workstation The workstation on which Objet software is installed, used 
for preparing build trays for production on Eden printers. 
(There is no limit to the number of client workstations in the 
local network.)

Eden™ printer The Eden500V/Eden350V/Eden350 3‐D printer referred to in 
this guide.

Eden computer The computer inside the Eden printer that operates it. (This is 
sometimes referred to as the “embedded” computer.)

Eden printer interface The GUI (graphical user interface) used for controlling the 
Eden printer.

Eden software Software running on the computer inside the Eden printer 
that controls all printer operations.

host/server workstation The workstation on which the full version of Job Manager is 
installed. This workstation interfaces directly with the Eden 
printer and is typically positioned next to it.

Job Manager™ The software that manages production jobs before they are 
sent to the Eden printer. 

model material Material used for building models.

Objet Studio™ The software with which users prepare jobs for producing 
models.

OTF (Objet Tray Format) The file type containing all of the information needed for a 
model‐building job on Objet 3‐D printers.

resin The base substance from which photopolymer printing 
materials are made for use in Eden printers. In Objet Studio, 
Job Manager and Eden software, “resin” refers to cartridges 
of model and support materials.

SLC A file type used with Objet software. (These files are bitmaps 
of individual slices of the object. For more information, see 
page 3‐4.)

STL A file type used with Objet software. (For more information, 
see page 3‐4.)

support material Material used for supporting the structure of models during 
production.
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Safety Features
Eden 3‐D printers are designed and manufactured to comply with CE and 
FCC standards. They are equipped with the following safety features:

Cover lock The cover is locked while the printer is 
working. It is released when the printer reverts 
to pause or stop mode.
WARNING: Do not defeat the safety lock. 
Doing so could result in serious personal 
injury. If the safety lock does not function 
correctly, contact your service provider.

Cover interlock 
switch

The internal AC power supply (to the UV lamp, 
motion motors and the tray heater) is turned off 
when the cover is opened.
WARNING: Do not defeat the interlock 
switch. Doing so could result in serious 
personal injury. If the interlock does not 
function correctly, contact your service 
provider.

UV screen  The transparent section of the cover blocks 
harmful UV radiation, allowing the operator to 
view the model as it is being made.

Circuit breaker The main power supply is turned off by an 
internal switch in case of an electrical 
malfunction.

Grounded chassis The frame and chassis of the printer are 
grounded to prevent electrical shock.

If the Eden 3-D printing system is not used as specified in this guide, the 
safety features may not provide adequate protection.
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Symbols and Warnings
This following table lists the warning labels located on or in Eden printers.

Warning 
Symbol

Meaning Location Comments

Hazard (general) The main label on 
the back of the 
printer.

Caution.

Hot surface  Near head block. Risk of burns. Do 
not touch this 
surface when hot.

High voltage  Near UV lamp 
connectors, on 
the rear, left and 
right covers of 
the UV enclosure.

Risk of electric 
shock.

Ultraviolet 
radiation

Near UV lamps Risk of injury from 
ultraviolet radiation. 
Always use 
protective eyewear 
during operation.

Moving parts Near tray
Near UV power 
supply

Risk of injury from 
moving parts.
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Safety Guidelines
The following general guidelines, together with the instructions provided 
throughout this user guide, ensure user safety while operating and 
maintaining the Eden system. If the system is not operated as specified, the 
userʹs safety may be compromised.

Eden Printer Installation and removal of the Eden printer should only be done by 
qualified service personnel. 
The Eden printer should only be operated by persons trained by an 
Objet customer‐support representative.
Service operations should be performed only by personnel who have 
been instructed in relevant safety precautions.
All personnel operating or maintaining the Eden printer should know 
the location of first aid and emergency equipment and how to use it. 
Never block access to this equipment.
Never attempt to open the main cover of the printer while it is working. 
Never bypass the interlock safety switch.
If the interlock safety switch ever fails, or if servicing is ever necessary 
while the main cover is open, never stare directly at the UV lamps 
without glasses that screen out UV radiation. For this purpose, 
ordinary sunglasses with UV screening are adequate.
Never connect the power plug to a socket that does not have a ground 
(earth) wire, and never disconnect the ground. Doing so may expose 
the operator to serious danger from electric shock.
The power cable should be connected at an easily accessible electric 
socket near the printer.
Never insert screwdrivers, wires, or other objects into the power supply 
housing. 
Leave a minimum of 15 centimeters between ventilation openings and 
walls or other objects.
Several parts of the printer remain extremely hot even after it has 
stopped operating. Avoid touching the main power supply, the UV‐
lamp power supply, UV lamps, and the print heads.
Notify co‐workers and those who have access to the Eden system before 
beginning non‐routine and hazardous work.
Report any potential dangers and safety‐related accidents to your 
safety officer or to other appropriate authorities.
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Model and 
Support 
Material

Model and support materials are made of resins. Although precautions 
must be taken when handling resins directly, all model and support 
materials used by the Eden system are handled in sealed cartridges. 
Normally, operators of the Eden printer should never be directly exposed 
to dangerous materials. Most of the following recommendations for 
handling resins apply to the unlikely event of a leak or spill. If this should 
occur, follow the specific instructions printed on the printing‐material 
cartridge used.

Store cartridges of model and support materials indoors, in a dry area 
with adequate ventilation, between 16‐27 degrees Celsius (60‐81 
degrees Fahrenheit). Never expose them to flames, heat, sparks, or 
direct sunlight.
Keep model and support materials away from areas where food and 
drink are stored, prepared and consumed.
Uncured resin is considered a hazardous material, requiring certain 
precautions when handling it. To prevent skin irritation, wear 
protective gloves, if necessary. If there is any chance that model and 
support materials might splash into the eyes, wear safety goggles. 
Prolonged direct contact with resins can cause an allergic reaction.
To prevent respiratory irritation, ventilate areas where model and 
support materials are used. The ventilation system should totally 
replace the air 20 times per hour.
Clean model‐material and support‐material spills with disposable 
towels or other absorbent, non‐reusable material, such as sawdust or 
activated charcoal. Rinse the spill area with denatured or isopropyl 
alcohol (IPA), followed by soap and water. Dispose of the absorbent 
material in accordance with local regulations.
Do not wash contaminated clothing at home; clothing should be 
professionally laundered.
Dispose of contaminated shoes, belts and other leather items. Absorbed 
resin may re‐expose the user when these items are worn again.
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First Aid for Working With Resins
In general, try to avoid direct contact with uncured resin. If skin or eyes 
come into contact with resin, wash the area immediately and thoroughly 
with water, and follow the first‐aid instructions below.

Contact with 
Skin

If uncured resin comes in contact with skin, wash the affected area 
immediately and thoroughly with soap and cool water, then remove 
contaminated clothing. Pay particular attention to flushing the hair, ears, 
nose and other parts of the body that are not easily cleaned. 

Use cool water to prevent skin pores from opening, so that the resin 
does not easily penetrate the skin. 
Do not use solvents to clean skin. 
If large areas of skin have been exposed to resin, or if prolonged contact 
results in blisters, seek medical attention. 
Avoid the accidental transfer of resin from the hands to other areas of 
the body, especially to the eyes. 
If protective cream was used, do not reapply it until the skin has been 
completely cleansed.

Contact with 
Eyes

If uncured resin comes in contact with the eyes, flush immediately with 
large amounts of water for 15 minutes and seek medical attention. 

Avoid sunlight, fluorescent light, and other sources of ultraviolet 
radiation.

The wearing of contact lenses when working near resin is not 
recommended. If resin splashes into the eyes when contact lenses are worn, 
immediately remove the lenses and flush the eyes with water. 

Clean and disinfect the contaminated lenses.
Do not wear contact lenses until eye irritation disappears.

Ingestion If resin is swallowed, refer to the cartridge label for specific instructions. 
Seek medical attention immediately.

Inhalation Resin vapors can be irritating to the respiratory system. If respiratory 
irritation occurs, expose the victim to fresh air immediately.

If the victim has stopped breathing, perform artificial respiration or 
cardiopulmonary resuscitation. 
Seek medical attention immediately.
Keep the patient warm but not hot. 
Never feed anything by mouth to an unconscious person.
Oxygen should be administered by authorized personnel only.
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Waste Disposal 
Fully cured resins present no special safety or health‐related issues. 
However, check if local regulations regard cured and partially cured resins 
as hazardous industrial waste, and comply with all applicable regulations 
governing their disposal.

When removing the waste container from the Eden printer, protective 
gloves are not required. When directly handling uncured resins, 
neoprene or nitrile gloves should be worn. 
When handling cured materials that may not be completely cured on 
the surface, common latex gloves are adequate. 
Even if not classified as hazardous industrial waste or otherwise 
regulated, resin materials must be packaged and disposed of in a 
manner that prevents human contact with the waste. Therefore, take 
steps to prevent the contamination of both groundwater and surface 
water.
Empty model‐material and support‐material cartridges are sealed to 
prevent leakage. Do not attempt to reuse them, and do not puncture 
them.
Discard contaminated clothing, shoes, empty containers, etc., in 
accordance with any applicable laws and regulations.
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Figure 3-1: The Eden500V/Eden350V/Eden350 3-D Printer

Work Configurations
The Eden 3‐D printing system can be set up as a single‐station system or as 
a multi‐station system. When connected to a local computer network, the 
system can serve multiple users. In such configurations, each user 
workstation (client) prepares files with Objet Studio software for 
production. A server (host), typically next to the 3‐D printer, acts as a job 
manager that sends production jobs to the printer for production. 
Figure 3‐2 shows the Eden printer set up in a multi‐client configuration.
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Figure 3-2: Multi-client network configuration

When installing the Objet software, you choose whether to install it as a 
client station or as a master station (server or standalone station).
The Objet software arranges the jobs it receives according to their priorities, 
model‐material type, and other factors. In multi‐workstation 
configurations, the operator of the server—typically the production 
administrator—has total control over the jobs sent to the 3‐D printer, and 
can prioritize and delete jobs, review job history and reprint a job, and so 
on.

Source Files 
Eden 3‐D printing systems produce three‐dimensional models designed 
with most 3‐D CAD tools and with other job‐specific 3‐D applications. 
Eden systems accept:
• STL files
• SLC files
Eden systems feature the capability of producing both types of model files 
simultaneously.

Eden server

Eden printer

KVM switch

Client 
workstations

Printer 
workstation
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STL Files STL is short for Standard Triangulation Language. This language views any 
object as a collection of surfaces, and describes each surface of the object as 
a collection of triangles. 
For example, a square can be described as two triangles; a cube (six 
squares) as 12 triangles. Curved surfaces need more triangles to describe 
them. The higher the tolerance (for smooth surfaces), the more triangles are 
needed. The result is that high‐quality object descriptions mean very heavy 
files. 
Most CAD software can export STL files. The Eden system utilizes these 
files for building models (rapid prototyping), and also for directly making 
molds for mass‐producing items.
STL files are ASCII (text) files. The content of each file begins with “solid” 
and ends with “end‐solid” (both lower case). Between these keywords is a 
list of the triangles that describes the faces of the solid model. Each triangle 
defines a single normal vector directed away from the solid’s surface, 
followed by its X‐Y‐Z coordinates. These are expressed as Cartesian 
coordinates and are floating‐point values. The coordinates of all triangles 
should be positive and should fall within the volume of the model. 

SLC Files SLC is short for Stereo‐Lithography Contour. SLC files describe two‐
dimensional contours of the three‐dimensional models. These contour lines 
are polylines. 
SLC files are ASCII (text) files that save models as a series of slices. This 
means that models based on SLC files cannot be orientated; only their scale 
(size) and position on the build tray can be controlled. For this reason, the 
model’s orientation must be suitable for production before it is saved as an 
SLC file. Because of the nature of SLC files, the appearance of models in 
Objet Studio may be different than the solid‐object images displayed from 
STL files.

Printing Materials
Materials used for printing models with Eden printers are made of resins, 
which are composed of reactive monomers and oligomers. Care must be 
taken when storing and handling them, both to protect operators and the 
environment, and to ensure their effectiveness. 
Signs of premature polymerization in material cartridges may include 
bulging, leaking, the emission of heat, and unusual odor. Exposure to heat 
can cause resin to gel in the cartridge. To prevent this, observe the following 
guidelines when handling and storing Eden modeling and support 
materials.
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Storage Printing materials used with Eden systems are supplied in UV‐proof 
cartridges. 
• To ensure product stability, do not allow these materials to come into 

contact with metal. Plastics made from monomer‐soluble substances 
(such as polystyrene or polyvinyl chloride) are not suitable for storing 
Objet printing materials.

• When not in use, keep material cartridges tightly sealed to prevent 
contamination, the effects of exposure to UV radiation, and accidental 
spillage. 

• Store material cartridges indoors, in a dry area with adequate 
ventilation, between 16–27 degrees Celsius (60–81 degrees Fahrenheit). 
If exposed to heat or flames, cartridges may burst or ignite.

• Make sure that material cartridges are stored in accordance with all 
local regulations and other applicable requirements.

Shelf Life Materials used for producing models have a limited shelf life. The expiry 
date on the label is valid when properly stored in an undamaged, 
unopened cartridge. Always rotate your stock, so that the cartridge with 
the earliest date is used first.

Light If printing materials are not in their sealed cartridges, make sure to shield 
them from sunlight and other sources of UV radiation, such as fluorescent 
and mercury‐vapor lights. Exposure to UV radiation causes an increase in 
viscosity and, eventually, solidification.

Safety 
Considerations

Before being cured, resins are hazardous materials. To prevent possible 
health hazards, follow these precautions regarding printing materials: 
• Do not expose to flames, heat or sparks.
• Prevent contact with skin and eyes.
• Ventilate areas where they are handled. 
• Keep them separate from food and drink.
Cured plastic parts, however, are safe. They can be handled and stored 
without precautions.

Disposal Dispose of cartridges of Objet model and support material in accordance 
with all applicable laws and regulations. If necessary, the cartridges can be 
disassembled for recycling. 

Work Environment
Extreme heat and humidity conditions can adversely affect the operation of 
the Eden 3‐D printer. Therefore, it is recommended that you use ventilation 
or air‐conditioning systems, if necessary, to keep the work area within the 
following ranges:
• 18°–25° C (64°–77° F)
• 30%–70% relative humidity

You can find more safety information about resins in “Safety Guidelines” on 
page 2-4, and “First Aid for Working With Resins” on page 2-6.
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Workstation Requirements 
The minimum requirements for computer components used with Objet 3‐D 
printer software are listed in the following table.

Preparing Files for Use with Eden 3-D Printing Systems
Before using files with Eden 3‐D printing systems, you must convert them 
in your CAD program to either STL files or SLC files. (For an explanation of 
these file formats, see “Source Files” on page 3‐3.)
After converting the model files, it is recommended that you check them for 
defects in an STL‐repair application (such as Magics, by Materialise) before 
opening them in Objet Studio and producing the model.

Converting 
CAD Files to 
STL Format

This procedure may vary slightly, depending on the CAD software used, 
but the following instructions generally apply.

To convert a file to STL format (in a CAD program):
1. From the File menu, select Save As.
2. In the Save As dialog box, open the Save As Type pull‐down menu and 

select *.STL.
3. Click Options and set the following parameters:

• Total Quality—approximately 0.1 mm (deviation tolerance / linear‐
dimension tolerance)

• Detail Quality—approximately 4° (angle tolerance)
Note: Lowering these values produces more accurate models, but 
results in larger files and longer loading and processing times. For this 
reason, it is generally not recommended that you use lower values.

Server/
Stand-alone Station

Client Workstation

Processor Pentium 4, 3.0 GHz, 
512 KB cache memory (min.)

Pentium 4, 3.0 GHz (min.)

Operating System Microsoft Windows XP or 
Windows 2000

Microsoft Windows XP or 
Windows 2000

Graphics Card Supporting open GL, 
with 256 MB of memory

Supporting open GL, 
with 256 MB of memory

RAM 2 GB (min.) 1 GB (min.)

CD Drive IDE CD ROM IDE CD ROM

Hard-Disk Drive 40 GB (min.) 40 GB (min.)

Network Adaptor 
Cards

LAN TCP/IP (2) LAN TCP/IP (1)

Ethernet Cables •Straight‐through cable (1)
•Crossover cable (1, supplied)

Straight‐through cable (1)
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4. In the file format option, choose binary or ASCII. (Binary files are 
smaller than files saved in ASCII format; they are, however, 
functionally identical in Objet Studio.)

5. Click OK or Save.

Converting 
Files to SLC 
Format

When converting files to SLC format, it is recommended that you set a layer 
thickness of 15 microns (0.015 mm). Since SLC files cannot be orientated in 
Objet Studio, it is important that models are properly orientated before 
being saved as SLC files. Considerations for suitable model orientation are 
explained in “Model Orientation” on page 5‐10.

Objet Software
Objet software for the Eden 3‐D printing system consists of two 
applications:
• Objet Studio
• Job Manager

Objet Studio
With Objet Studio, you prepare source files for production in Eden 3‐D 
printers. Objet Studio offers you a wide variety of file‐preparation options, 
but always consists of the following basic procedure:
1. Inserting one or more objects on the build tray
2. Positioning the object(s) on the tray
3. Configuring object and tray parameters
4. Saving the tray configuration as an otf (Objet Tray Format) file
5. Sending the otf file to the Eden 3‐D printer for production
Using Objet Studio to perform these tasks is described in detail in chapter 5, 
“Using Objet Studio”.”

Job Manager
The Job Manager application is different for client workstations and for the 
computer connected directly to the Eden 3‐D printer. 
• Job Manager installed on the directly‐connected computer (server) 

displays the queue and status for all jobs sent to the 3‐D printer by the 
client computers on the network, and allows editing and manipulation 
of all jobs. 

• Job Manager installed on client computers displays the queue and 
status only for jobs sent to the 3‐D printer server from that computer, 
and allows the user to edit only these jobs. 

Job Manager is described in detail in chapter 6, “Using Job Manager.”

Client computers can be connected, via the local network, to different Eden 
3-D printers, but only to one at a time. The client Job Manager displays the 
status of the 3-D printer to which the client is currently connected.
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How to Install Software for the Eden 3-D Printing System
The Objet Studio setup wizard guides you when installing the Objet 
software. During installation, you must choose to install either the server 
(“host”) application or the client application. 

To install Objet software:
1. Insert the Objet Studio CD into the disk drive.
2. Right‐click the Start button and select Explore (or use any other method 

for displaying files on the computer).
3. Open the CD‐drive folder and select Setup.

Figure 4-1:Objet Setup—installation wizard Welcome screen

4. When the Welcome screen appears, click Next.

Figure 4-2: Objet Setup—Select Components screen
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5. When the Select Components screen appears, select one of the 
installation options, then click Next.
• Select Objet Studio only for client workstations
• Select Objet Studio and Job Manager for the server (host) station and 

for a standalone station—that is, the computer directly connected to 
the Eden printer.

Figure 4-3: Objet Setup—Choose Destination Location screen

6. In the Choose Destination Location screen, verify the destination folder 
and click Next. 

Figure 4-4: Objet Setup—Select Program Folder screen

It is recommended that you do not change the default destination folder.
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7. In the Select Program Folder screen, verify the pre‐selected folder in 
which the Objet Studio icons will be installed. 
• To install the icons in another program folder, select it. 
• To continue, click Next.

Figure 4-5: Objet Setup—Select Printer Type screen

8. In the Select Printer Type screen, select the Objet 3‐D printer used for 
producing models. 
To continue, click Next.
Installation begins and the Setup Status screen appears, showing the 
progress of the installation process.

Figure 4-6: Objet Setup—Setup Status screen
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When the Objet program installation is complete, the final InstallShield 
Wizard screen appears.

Figure 4-7: Objet Setup—final wizard screen

9. To complete installation, you must restart the computer. To do so, 
remove the CD from the disk drive, select “Yes…” and click Finish.

The computer shuts down and restarts, and the software installs the 
appropriate icon(s) on the computer desktop: 
• Objet Studio
• Job Manager (for servers and standalone stations)
• Stop Job Manager (for servers and standalone stations)
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Opening Objet Studio
After you install Objet Studio, a launch icon   appears on the 
Windows desktop. Open the application by double‐clicking this icon, or by 
selecting Objet Studio from the Start > Programs menu.
Objet Studio opens, displaying an empty build tray.

Figure 5-1: Objet Studio opening screen

Toolbars The icons shown in this chapter are available only when relevant toolbars 
are displayed. You can control the toolbars displayed at any time, and you 
can re‐arrange them on the screen.

To customize the toolbars displayed in Objet Studio:
1. From the View menu, select Toolbars.
2. In the Customize dialog box, select the toolbars you wish to display, and 

click OK.

Figure 5-2: Toolbar selection dialog box

3. Click and drag the toolbars to position them as you wish on the Objet 
Studio screen.
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Preparing Models for Production
To produce models, you must open one or more files in Objet Studio and 
position the objects on the build tray. You can place objects on the build tray 
in two ways:
• by inserting individual stl or slc files 
• by pasting objects that you copied to the Windows clipboard
If you know what type of model material will be used to produce the 
models, make sure it is selected from the material drop‐down menu.

Figure 5-3: Model material selection toolbar

Note: It is not necessary to select the model material now, but it is 
recommended—each type of material has unique characteristics 
that may affect the valid positioning of objects on the build tray.

Opening STL 
& SLC Files

To place an object on the build tray:
1. Open the Insert dialog box—

• From the Object menu, select Insert.
or—
• On the toolbar, click the Insert Model icon  .
or—
• Right‐click on the build tray, and select Insert.
The Insert dialog box appears.

Figure 5-4: Insert dialog box

2. In the Look in field, display the appropriate folder.
3. In the Files of type field, select the file types to display (stl, slc).
4. Select the desired file, and make sure that it appears in the File name 

field.
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If the Preview check box is selected, the object is displayed in the dialog 
box, as shown in figure 5‐4.

5. Select any of the following options, as required:
• Units—Choose millimeters or inches for the object’s units of measure.
• Number of copies—Choose how many copies of this object to place 

on the build tray.
• Arrange models—Select this check box to automatically position 

objects on the build tray for efficient model building.
Note: The 3-D file contains the object's proportions, but not its units of 
measure. Therefore, make sure to correctly select either millimeters or 
inches when inserting an object. Otherwise, the size of the object on the 
build tray will be either much too large or much too small. 

6. Click Open.
Objet Studio places the object on the build tray, and in the list in the 
hierarchy pane.

Figure 5-5: Default screen layout

You can place additional objects on the build tray by repeating this 
procedure.

The Extents values displayed at the bottom of the dialog box represent the 
maximum dimensions of the object on each axis. These dimensions 
correspond to the virtual “bounding box” surrounding the object (see 
figure 5-24 on page 18).

Hierarchy 
pane

Build tray

Object 
properties
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Copying and 
Pasting 
Objects

If you need to duplicate objects on the build tray, you can, of course, insert 
the same object from its file more than once. An easier way, however, is to 
copy and paste the object. You can copy objects from the build tray or the 
hierarchy pane. The objects copied remain in the Windows clipboard until 
you paste them onto the build tray. 
You can also copy objects from one tray and paste them onto another, in the 
same way as you copy text from one document and paste it into another 
one. However, Objet Studio allows only one tray to be open at a time. For 
each build tray you need to work with (at the same time), you must open a 
separate Objet Studio window, by running the application again (from the 
Windows Start menu).

You perform the Copy and Paste commands as in other Windows 
applications:
• from the Edit menu, on the main toolbar
• from the right‐click context menu
• by using keyboard shortcuts (Ctrl+C and Ctrl+V, respectively)
The Paste Special command (in the Edit menu) enables you to place 
duplicate objects even more efficiently:
• You can specify the number of duplicates to place on the build tray at 

once.
• You can set the distance, on each axis, between the duplicate objects.
• You can place mirror images of the original object.

Figure 5-6: Paste Special dialog box

Selecting 
Objects

To manipulate an object on the build tray or assign characteristics to it 
(surface finish, for example), you must first select the object. You select an 
object by clicking it, either on the tray or in the tray hierarchy pane. Its 
image on the build tray changes color (to light blue, by default) and its 
name is highlighted in the tray hierarchy pane. You can select multiple 
objects by pressing the Ctrl or Shift keys while clicking additional objects.

Having multiple Objet Studio windows open can be convenient when you 
need to manipulate or configure objects before inserting them in your 
production build tray. Copying and pasting also allows you to utilize objects 
already configured on previously-used build trays for newer projects.
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Arranging the Objet Studio Screen
The default screen layout displays the perspective view of the build tray and 
the tray hierarchy pane, which lists the elements placed on the tray (see 
figure 5‐5 on page 4). You can view models from different angles by 
changing the screen layout.

To change the Objet Studio screen layout:
From the View menu, select Layout, then the desired number of build‐
tray views.

2 Views is the default screen layout, already displayed (see figure 5‐5 
on page 4).
By default, the Entity Properties dialog box is also displayed.
3 Views adds top and front views to the default screen layout (see 
figure 5‐8, below).
4 Views displays top, front and right views (see figure 5‐9).
1 View expands the perspective view to fill the screen (see figure 5‐10).

You can also change the screen layout with toolbar icons.

Figure 5-7: Screen layout icons

Figure 5-8: 3-view screen layout
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Figure 5-9: 4-view screen layout

Figure 5-10: 1-view screen layout

You can change the perspective of the active viewing pane by clicking any 
of the nine viewing icons.

Figure 5-11: Viewing-pane perspective icons
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Positioning Objects on the Build Tray
To produce models efficiently and with the required finish, it is important 
to carefully position objects on the build tray. Objet Studio features the 
automatic positioning of objects. However, you should check to make sure 
that the objects are orientated logically for your needs, according the 
considerations explained in “Model Orientation” on page 10.

Automatic 
Positioning

There are two ways to have Objet Studio position the items on the build 
tray.
• Anytime you insert an object onto the build tray, select Arrange models 

in the Insert dialog box.

Figure 5-12: Arrange models option in the Insert dialog box

When you click Open, Objet Studio inserts the new object and arranges 
all of the objects on the build tray.

• After placing several objects on the build tray, select Tools > Automatic 
Placement.

The effects of automatic placement are shown in figures 5‐13 and 5‐14.
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Figure 5-13: Tray before objects are properly arranged

Figure 5-14: Tray after objects have been automatically arranged

Manual 
Positioning

You can manually position objects on the build tray—even if they were 
inserted using automatic placement (with the Arrange models option 
selected in the Insert dialog box). Considerations for positioning objects are 
reviewed in “Model Orientation” on page 10. Tools for changing the 
position of objects are described in “Repositioning Objects” on page 12.

Because of the unique characteristics of each type of modeling material, it 
is recommended that you select the material before inserting objects on the 
tray with automatic positioning or running Automatic Placement.
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Model Orientation
The orientation of models on the build tray affects how quickly and 
efficiently they will be produced by the 3‐D printer, where and how much 
support material is used, and whether or not model parts will have a gloss 
finish. Therefore, you should consider a variety of factors when deciding 
how to place models on the tray, using the following positioning rules. 

X-Y-Z Rule
This rule considers a modelʹs outer dimensions.

Since the print heads move back and forth along the X‐axis, the printing 
time along this axis is relatively short, compared to printing time along 
the Y‐axis and Z‐axis. From this point of view, it is advisable to place the 
objectʹs longest dimension along the X‐axis.
Since high‐resolution models are built up, on the Z‐axis, in 16‐micron 
layers, it is very time‐consuming to print a tall object. From this point of 
view, it is advisable to place the objectʹs smallest dimension along the Z‐
axis.
Since the print heads measure about 2 inches (5 centimeters) on the Y‐
axis, models measuring less than this (on the Y‐axis) are printed in one 
pass. From this point of view, it is advisable to place the objectʹs 
intermediate dimension along the Y‐axis.

Tall-Left Rule
This rule considers models where, after being orientated on the build tray 
according to other considerations, one side is taller than the other.

Since the print heads move along the X‐axis from left to right, taller 
sections on the right require the print heads to scan unnecessarily from 
the left until reaching them. If, on the other hand, the taller sections are 
positioned on the left of the tray, the print heads only have to scan the 
model until printing these sections—once the lower parts have been 
completed. Therefore, you should position the taller side of the model, 
when possible, on the left.

Recess-Up Rule
This rule considers models containing surface recesses.

Recesses in the surface (like hollows, drill holes, etc.) should, when 
possible, be positioned face‐up.

Fine-Surface Rule
This rule considers models that have one side on which there are fine 
details (like the keypad side of a telephone).

The side of the model containing fine details should, when possible, be 
positioned face‐up. This results in a smooth finish.

The following rules are based on the fact that support material is not 
required on the top of the printed model.
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Avoid Support-Material Rule
This rule considers models that have large holes or hollows, open on at 
least one side (like a pipe or a container).

It may be advantageous to print a model standing up, so support 
material does not fill the hollow, even though printing the model lying 
down would be much faster.

Manipulating Objects on the Build Tray
Object Position 
on the Z-Axis

When you use automatic positioning to arrange objects on the build tray 
(see “Automatic Positioning” on page 8), the objects are positioned directly 
on the tray. If you do not insert objects with automatic positioning, they 
often appear either above or below the tray.

To position objects directly on the tray: 
1. Select the object.
2. Click the Lay On icon  .

or—
From the Object menu, select Lay On.

To ensure that objects are always directly positioned on the tray:
1. From the Tools menu, select Options, and display the Settings tab.

Figure 5-15:Options dialog box, Settings tab

2. In the Automatic Lay On (Gravity) section, select Always. (This is the 
default setting.)

In practice, the Eden system prints all models on the build tray on a one-
millimeter bed of support material. The importance of positioning objects 
directly on the build tray with Objet Studio is to correctly display the objects 
on the screen.
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Other Z-axis options (in the Automatic Lay On section):
• When under the tray—The display of objects that are below the build 

tray is automatically changed so that the object is at tray level.
• Never—The display of objects that are above or below the build tray is 

not changed.

Repositioning 
Objects

You can select and manipulate objects on the build tray after selecting the 
following icons or menu options.

After using these repositioning icons once, they are disabled, unless you 
first click the Sticky Mode icon  . After clicking this icon, the repositioning 
icon used remains active until you click the Sticky Mode icon again to 
release it.
Another way of repositioning objects on the build tray is by using the icons 
on the Transform toolbar that nudge the selected object in different ways. 

Viewing Object Properties
After you manually manipulate an object with the mouse, its new 
properties are displayed in the Transform tab of the Entity Properties dialog 
box. 

Icon Menu 
Option

Purpose What to do

(none) For selecting an object. Click the object on the build tray.

Object > 
Translate

For selecting and moving 
an object with the mouse.

Click the object to select it.
Drag the object to a new location 
while holding down the mouse 
button.

Object > 
Rotate

For selecting and rotating 
an object on the Z‐axis.

Click the object to select it.
Hold down the left mouse button 
and move the mouse left/right.

Object > 
Scale

For selecting and 
changing the size an 
object.

Click the object to select it.
Hold down the left mouse button 
and move the mouse left/right.

Click to move the object 20 mm along the X‐axis.

Click to move the object 20 mm along the Y‐axis.

Click to move the object 30 degrees on the Z‐axis.

Click to rotate the object 30 degrees on the X‐axis.

Click to rotate the object 30 degrees on the Y‐axis.

Click to rotate the object 30 degrees on the Z‐axis.

The Entity Properties dialog box is displayed by default (see figure 5-5 on 
page 4) and whenever the screen layout is changed or refreshed (see 
“Arranging the Objet Studio Screen” on page 6).
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Figure 5-16: Entity Properties  dialog box, Transform tab

You can make precise changes to an object on the build tray by selecting the 
object (either on the tray or in the tray hierarchy pane) and changing its 
values in the dialog box.

Note: You can only change the height of the objects on the build tray if this 
is allowed by the Objet Studio settings (see “Object Position on the 
Z-Axis” on page 11.)

The properties displayed in the Transform tab of the Entity Properties dialog 
box are absolute values, representing the actual position of the object on the 
build tray. Another way of repositioning objects on the tray using precise 
values is by applying changes to object properties relative to the current 
position. There are two Relative Transform dialog boxes available: 
• The R. Trans tab of the Entity Properties dialog box.

Figure 5-17: Entity Properties dialog box, R. Trans tab
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• The Relative Transform dialog box, accessible from the Object menu.

Figure 5-18: Relative Transform dialog box

Valid Object 
Placement 

To ensure that models do not overlap when you position them on the build 
tray, you can select the Dynamic Checking icon   from the Tools toolbar. 
When selected, Objet Studio only allows the positioning of objects if they 
do not interfere with other objects on the tray. Note that the space occupied 
by an object includes the “bounding box” surrounding it (see figure 5‐24 on 
page 18). 

Note: Because of the unique characteristics of each type of modeling 
material, it is recommended that you select the material before 
precisely positioning objects on the tray.

Grouping and 
Ungrouping 
Objects

You can manipulate two or more objects on the build tray, at the same time.

To group objects:
1. Select the objects (see “Selecting Objects” on page 5).
2. Click the Group icon  .

or—
From the Object menu, select Group.
In the tray hierarchy pane, the objects now appear under “Group 
Element.” 

Figure 5-19:Group Element in the tray hierarchy pane

To separate grouped objects:
1. Select the group element (either on the build tray or in the tray 

hierarchy pane).
2. Click the Ungroup icon  .

or—
From the Object menu, select Ungroup.

Even if you do not use Dynamic Checking when placing objects on the build 
tray, Objet Studio automatically checks if there is a problem with the 
positioning of objects on the tray before sending it to the printer. You can 
also manually check for problems after positioning objects (see “Tray 
Validation” on page 21).
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Using a Grid to 
Position 
Objects

Displaying a grid on the image of the build tray can be useful when 
positioning objects. You can make use of this feature by clicking the grid 
toolbar icons or by selecting menu options. 

You can review and configure grid settings—and apply them—from the 
Options dialog box.

To use the Options dialog box:
1. From the Tools menu, select Options, and display the Grid tab.

Figure 5-20:Options dialog box, Grid tab, showing the default settings

The dialog box displays the current grid settings.
2. As required, make changes to the settings, and select or clear the check 

boxes.
3. Click Apply or OK.

Changing an 
Object’s 
Orientation

There are several methods for changing the orientation of objects on the 
build tray.

To rotate an object:
Select the object and use the Rotate icon or Object menu options (see 
“Repositioning Objects” on page 12).

Icon Menu Option Result

Tools > Grid Displays a grid over all build tray views.

Tools > Snap to grid When moving the object, it aligns with the 
nearest grid line.

Enables you to change the grid origin 
(X‐ and Y‐axis meeting point) by clicking 
on the build tray.

Cancels the changes made to the grid 
origin and restores the default grid.
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To select an object’s plane and re-align it with one of six basic directions:
• From the Plane Alignment toolbar:

1. Click the Select Plane icon  .
2. Click a plane on an object displayed on the build tray.
3. Click the appropriate align icon—

• From the Tools menu:
1. Select Plane Alignment > Select Plane.
2. Click a plane on an object displayed on the build tray.
3. Select Plane Alignment > Align Bottom/Top/Front/Back/Left/Right (as 

appropriate).

Note: When you are finished re-aligning the plane of objects on the build 
tray, release the Select Plane icon or clear Select Plane from the 
Tools > Plane Alignment menu.

To flip an object 180 degrees on any axis:
1. Select the object.
2. From the Object menu, select Flip > Flip X / Flip Y / Flip Z.

To make precise changes to the object’s orientation on any axis:
1. Select the object. 
2. Display the Transform tab or the R. Trans. tab of the Entity Properties 

dialog box (see figure 5‐16 on page 13 and figure 5‐17 on page 13).
or—
From the Object menu, select Relative Transform (see figure 5‐18 on 
page 14).

3. Change the Rotate values for the desired axis.

Freezing an 
Object’s 
Orientation

If you manipulate an object on the build tray, you can freeze its orientation 
so that it does not change when you perform Automatic Placement (see 
“Automatic Positioning” on page 8).

To freeze an object’s orientation:
1. Select a model on the build tray.
2. In the Options tab of the Entity Properties dialog box, click Advanced.

Align Bottom

Align Top

Align Front

Align Back

Align Left

Align Right
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The Advanced Properties dialog box opens.

Figure 5-21:Advanced Properties dialog box

3. Select the Lock Orientation check box.
4. Close the Advanced Properties dialog box.

Surface Finish Models can be produced with a matte or glossy finish. To create a matte 
finish, the printer surrounds models with a thin layer of support material. 
Models produced with a glossy finish are printed with a resolution of 300 
dpi (dots per inch) along the Y‐axis, instead of the standard 600 dpi 
resolution. 

Note: You can print a tray that contains models having both glossy and 
matte finishes. However, they will all be printed with a Y-axis 
resolution of 300 dpi.

To choose the finish type for a model:
1. Select the model.
2. In the Options tab of the Entity Properties dialog box, select Matte or 

Glossy.
or—
1. Right‐click the model on the build tray.

At the bottom of the context menu, the current finish type is not enabled 
(that is, you cannot select it).

2. To change the finish type, select the other (enabled) option.
You can distinguish between the finish of objects on the build tray by their 
color. When they are not selected, objects are displayed, by default, in a 
different shade of green for each finish. To change these‐color settings, see 
“Object Color Codes” on page 5‐49.

Display Options
From the View menu, you can change the way objects are displayed on the 
screen. The default method for displaying models on the build tray is as 
solid (“shaded”) objects. 
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Figure 5-22: Tray and model displayed in shaded view

The other display options are wire frame and points.

To display the build tray in wire frame view:
Select View > WireFrame or click the WireFrame icon  .

Figure 5-23: Tray and model displayed in Wire frame view

To revert to the shaded view:
Select View > Shaded or click the Shaded icon  .

To display objects as boxes, showing their maximum dimensions 
instead of the model geometry:

Select View > Display Bounding Box.

Figure 5-24: Model displayed with bounding box

To display the area around objects needed for support material (to 
produce a matte finish):

Select View > Display Thickening Box.
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Figure 5-25: Model displayed with thickening box

To change the display color of an object:
1. Select the object.

Its color changes to blue, indicating that the object has been selected.
2. From the Object menu, select Fill Color or click the Fill Color icon  .
3. Select a color from the color palette and click OK.

When the object is de‐selected, it appears in the new color.

Note: You can repeat this procedure for other objects, so that different 
objects on the build tray are displayed in different colors.

Tray Viewing 
Options

The Objet Studio toolbars contain several icons for changing the 
appearance of the display screen, enabling you to view the tray and objects 
in different magnifications and from various perspectives.

Note: You must display the relevant toolbar(s) to access many of the icons 
described below (see ).

Objet Studio displays objects to be produced with matte and glossy finishes 
in different colors. See “Surface Finish” on page 17 and “Object Color 
Codes” on page 22

Icon Tool Tip Name Purpose

Zoom Full Reverts to normal view after using various 
zoom options. (The same as  .)

Zoom Object  Fills the viewing pane with the selected 
object(s).

Zoom Work Area Reverts to normal view after using various 
zoom options. (The same as  .)

All Windows If enabled,   and   effect all viewing 
panes.

Perspective/Parallel When selected, the tray is displayed with depth 
perspective—closer objects appear bigger. 
When not selected, the tray is displayed in two 
dimensions—identical objects appear the same 
size, regardless of their position on the screen.

Zoom By Rectangle Fills the active viewing pane with an area of the 
build tray after you select it with the mouse.
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Zoom Dynamic Continuously zooms in/out of the point at 
which you click and hold down the left mouse 
button, when you move the cursor up and 
down.

Pan By Line Moves the build tray in the viewing pane 
according to the line you extend on the screen 
with the left mouse button.

Pan Dynamic Moves the build tray in the viewing pane as 
you move the cursor on the screen while 
holding down the left mouse button.

Walk Dynamic Zooms and moves the build tray as you hold 
down the left mouse button and move the 
cursor on the screen.

Study Dynamic Enables you to inspect the build tray from 
every angle and perspective. As you hold 
down the left mouse button and move the 
cursor on the screen, the view of the build tray 
changes.

Spin Mode When used with   and  , the movement of 
the build tray continues after you release the 
mouse button. To stop the movement, click in 
the active view pane or click one of these icons.

Zoom In Each mouse click zooms one step to the center 
of the active viewing pane.

Zoom Out Each mouse click zooms‐out one step from the 
center of the active viewing pane.

Pan Left Each mouse click moves the build tray to the 
left in the viewing pane by one step.

Pan Right Each mouse click moves the build tray to the 
right in the active viewing pane by one step.

Pan Up Each mouse click moves the build tray up in 
the active viewing pane by one step.

Pan Down Each mouse click moves the build tray down in 
the active viewing pane by one step.

Advance Forward The same as  . Each mouse click zooms in to 
the tray displayed in the active viewing pane.

Advance Backward The same as  . Each mouse click zooms out 
of the tray displayed in the active viewing 
pane.

Rotate Left Each mouse click rotates the build tray to the 
left in the active viewing pane by one step.

Rotate Right Each mouse click rotates the build tray to the 
right in the active viewing pane by one step.

Icon Tool Tip Name Purpose
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Handling Completed Trays
After you have properly placed all objects on the build tray, you save the 
tray as an otf file, which is sent to the 3‐D printer for production. But before 
saving the tray, you can check that there would be no problem producing it. 
You can also calculate how much material would be consumed during 
production and how much time this would take.

Tray Validation Before sending a job to the Eden printer for production, you should check 
that the tray is “valid” and can be printed.

Note: Because of the unique characteristics of each type of modeling 
material, make sure that the correct material is selected before 
performing Tray Validation.

To validate that the tray can be printed:
From the Tools menu, select Tray Validation.

or—
Click  .
If the tray is not valid, the color of the problematic models on the tray 
changes according to a pre‐set color code. If a warning message appears, 
click OK to close it.

Figure 5-26: Tray validation warning

Rotate Up Each mouse click rotates the build tray up in 
the active viewing pane by one step.

Rotate Down Each mouse click rotates the build tray down in 
the active viewing pane by one step.

Camera Displays a virtual camera and its viewing angle 
of the tray.

Icon Tool Tip Name Purpose
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Object Color 
Codes

To view the color code for objects displayed:
From the Tools menu, select Constraints Settings.

Figure 5-27: Constraints Settings dialog box, showing object color codes

To change the color settings:
1. Click the current color displayed in the Constraints Settings dialog box.
2. From the color palette that opens, select a color and click OK.

Note: The color of objects already displayed does not change 
automatically. The color change tales effect the next time an object’s 
state is changed.

Quality/Speed 
Setting

When producing models on Eden500V and Eden350V printers, Objet 
Studio allows you to choose the quality/speed setting most suitable for 
your project. (Eden350 printers operate in High Quality mode only.)

High Quality—
• Prints models in 16‐micron layers, suitable for producing fine details 

and delicate items.
• Requires much more time to print most trays, compared to High Speed 

setting.

High Speed—
• Prints models in 29‐micron layers, suitable for producing larger 

models.
• Requires much less time to print most trays, compared to High Quality 

setting.
If high speed printing is supported by the printer, the Quality/Speed 
selection buttons are available on the main toolbar. Change the setting, if 
necessary, before sending the tray to the 3‐D printer. 

Figure 5-28: Quality/Speed setting
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Production 
Estimates

Objet Studio enables you to calculate the time and material resources 
needed for producing trays before sending them to the Eden printer. The 
time it takes Objet Studio to make this calculation depends on the number 
of objects on the tray and their complexity. Calculating the production 
estimate for a full tray could take up to 15 minutes, depending on your 
computer’s specifications. The results displayed are accurate within 10 
percent of the actual resources needed.

To calculate the time and materials needed for producing the current 
tray:

From the Tools menu, select Estimate Consumptions.
or—

Click  .
When Objet Studio finishes calculating the production resources, the 
results are displayed at the bottom of the screen.

Figure 5-29: Production resource calculation

Note: Make sure to calculate production resources after selecting the 
Quality/Speed setting (see page 22). You can compare the required 
resources for each of the settings.

Saving the 
Tray File

Trays are saved as otf files. You can save a tray before it is ready for 
production, and open it at another time to continue preparing it. When you 
send the tray to the Eden 3‐D printer, it is first saved. If the tray was 
previously saved, its otf file is overwritten at this time.

To save the tray file:
From the File menu, select Save Tray or Save Tray As.

or—
Click  .

Printing the 
Tray File

When a tray is ready to be printed, it is sent to Job Manager, where it is 
placed in the print queue. When the job reaches the head of the queue, Job 
Manager pre‐processes the tray file to create slices, and feeds them to the 
3‐D printer.

To send the tray to the print queue:
From the File menu, select Build Tray.

or—
Click  .
If the build‐tray file has not been saved, the Save As dialog box opens 
for you to save it now. 
The tray file is sent to Job Manager, for printing. Objet Studio closes and 
Job Manager opens, so you can monitor the progress of your trays—
before, during, and after printing.

To return to Objet Studio from Job Manager, click New Job .
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Additional Objet Studio Features
Dividing 
Objects

You can use the Split Object feature to produce objects larger than the build 
tray by dividing the model into separate parts. With this feature, you 
produce only a specific section of a model.

To split an object:
1. Select the object.
2. From the Object menu, select Split.
3. In the Split Object dialog box, enter the values to determine how Objet 

Studio will divide the object. You can divide an object along any of its 
axes, by entering either exact measurements or the number of parts.

Figure 5-30:Split Object dialog box

4. In Save to Folder, enter the folder name.
5. Click OK.

The composite parts are saved as new stl files with “Part 1,” “Part 2,” 
etc., added to the original file name.

Note: Before printing the newly created stl files, it is recommended that you 
check them for defects in an STL-repair application, such as Magics, 
by Materialise. 

Choosing the 
Support 
Strength 

When producing models, support material fills some hollow and empty 
sections (see “Model Orientation” on page 10). Objet Studio allows you to 
adjust the strength of the structure formed with the support material. This 
adjustment is useful when producing either large/massive models or small/
delicate models. For most purposes, the default setting provides adequate 
support strength.

To change the strength of the support structure used when printing a 
model:
1. Select a model on the build tray.
2. In the Options tab of the Entity Properties dialog box, click Advanced.
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The Advanced Properties dialog box opens.

Figure 5-31:Advanced Properties dialog box—Grid Style selection

3. In the Grid Style section, choose the support strength suitable for the 
selected model:
• Heavy—for large models needing much support.
• Lite—for delicate models needing little support.
• Default—for models needing average support (most models).
Note: You can select a different support strength for each model on the 
build tray.

4. Close the Advanced Properties dialog box.

Displaying the 
Cross Section 
of Objects

The Section feature enables you to view the interior of an object by “slicing” 
it on any axis. You can then manipulate the object to inspect the interior 
from different angles. This may be important for deciding on the type of 
support necessary when producing the model (see “Choosing the Support 
Strength ” on page 24). Displaying an object’s cross section only affects how 
the tray is displayed on the screen; it does not change the object itself.

To display a cross section of the tray:
1. From the Tools menu, select Section.

or—
Click   on the toolbar.
The Section dialog box opens.

Figure 5-32:Section dialog box

The Lock Orientation option is not connected to the Grid Style selection. 
This setting is described in “Freezing an Object’s Orientation” on page 16.
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2. Select the Enable Clicking check box.
3. Use the slider controls for the X‐, Y‐, and Z‐axes to cut the tray so that 

you see the cross section you want.

Printing the 
Screen Display 
on Paper

You can print the view displayed in the active pane on a regular (paper) 
printer. Before printing, you can configure how the tray will be printed on 
the page, and you can display a screen preview of the printed page.

To access the paper printing controls:
From the File menu, select—

Page Setup…
Page Preview…
Print 

You can also print a paper copy of the tray by using the standard Windows 
keyboard shortcut for printing: Ctrl+P.

Saving the 
Screen Display 
as an 
Image File

You can save the image displayed in the active viewing screen as a graphic 
file.

To save the screen display as an image:
1. From the File menu, select Save Bitmap…

The Save Bitmap dialog box opens.

Figure 5-35:Save Bitmap dialog box

2. At the top of the dialog box, select the appropriate folder.
3. At the bottom of the dialog box, enter a file name.
4. Open the Save as type pull‐down menu, and select the file format.
5. Click Save.

Figure 5-33: Whole view Figure 5-34: Cross-section view, after 
using the Z-slider
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Exporting and 
Importing 
Objet Build 
Trays

When you save build trays in Objet Studio, they are saved as otf files. These 
files contain instructions to Objet Studio and to Eden 3‐D printers for 
displaying and producing the stl files used on the tray. To save all of the 
files that comprise the build tray, for storage or transfer to another location, 
Objet Studio compresses them into one ozf file. To open an ozf file in Objet 
Studio, the file must first be expanded and its component files saved.

To create an ozf file:
1. From the File menu, select Export Packed Job…

The Save As dialog box opens.
2. Select the appropriate folder and change the file name (if necessary).
3. Click Save.

To open an ozf file:
1. From the File menu, select Import Packed Job…
2. In the Open dialog box, display the appropriate folder and select the 

file.
3. In the Browse for Folder dialog box, display the folder in which you 

want Objet Studio to expand the compressed file, and click OK.
The otf file and associated stl files are expanded and placed in the 
selected folder, and the tray is displayed in Objet Studio.

Advanced-Mode Features
The Objet Studio features described in this section are only accessible if the 
application is set to Advanced mode. 

To see the current Objet Studio setting:
Open the Tools menu.

Figure 5-36: Tools menu, showing Advanced mode selected

If Advanced is checked, the advanced features are enabled. 
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To change the Advanced setting:
1. Click Advanced in the Tools menu.

The following message is displayed, reminding you that the change 
will only take effect the next time you open Objet Studio—even though 
the check mark in the Tools menu appears/disappears after you make 
the change.

Figure 5-37: Configuration-change message

2. Close and re‐open Objet Studio to access the Advanced mode features.

Save Tray As… In addition to saving the tray as an otf file, for producing it with an Eden 3‐
D printer, you can save a group of objects positioned on the tray as an stl 
file. You can then use this file as any other stl file, both in Objet Studio and 
in other applications. You can also display this and other stl files as 
“floating” objects, without the build tray. This is useful for inspecting 
objects from every angle.

To save the build tray as an stl object:
1. From the File menu, select Save Tray As…

Figure 5-38:Save As dialog box

2. At the top of the dialog box, select the appropriate folder.
3. At the bottom of the dialog box, enter a file name.
4. Open the Save as type pull‐down menu, and select STL Files (*.stl).
5. Click Save.
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To display stl files without the build tray:
1. From the File menu, select Open Tray.
2. In the Open dialog box, open the Files of type pull‐down menu, and 

select STL Files (*.stl).
3. Click Open.

A three‐dimensional image of the file is displayed. You can use many of 
the Objet Studio tools to manipulate the image on the screen.

Configuring 
the GL Driver

The GL driver displays 3‐D graphics on your screen. There is normally no 
reason to adjust its settings. If you suspect a problem with the way Objet 
Studio displays objects, you can use the OpenGL Driver Configuration tool 
to check and configure the driver settings. 

To access the OpenGL Driver Configuration dialog box:
1. From the Tools menu, select Options.
2. In the Options dialog box, display the Advanced tab and click OpenGL 

Driver Configuration…

Figure 5-39:Accessing GL-driver configuration

Note: If the Advanced tab is not displayed, activate the Advanced option in 
the Tools menu and re-open Objet Studio.
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The dialog box that opens contains tabs that display the pixel format ID 
(index) for the window and the memory.

Figure 5-40:OpenGL Driver Configuration dialog box

You can display the values and make changes to them by clicking  . 
Alternately, you can select Choose Format and change the values in this 
dialog box.

To perform a test of the driver configuration and enter the suggested 
pixel format ID:
1. Select Choose Format. 
2. Click Test.

Objet Studio returns the recommended pixel format ID.

Figure 5-41:Recommended pixel format ID

3. Click OK. 
4. In the OpenGL Driver Configuration dialog box (figure 5‐40), select 

Pixel Format ID and enter this number.
5. Click Apply.
6. Display the other pixel format tab, and repeat this procedure.
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The Job Manager application is different for client workstations and for the 
computer connected directly to the Eden 3‐D printer. 
• Job Manager installed on client computers displays the queue and 

status only for jobs sent to the 3‐D printer server from that computer, 
and allows the user to edit only these jobs. 

• Job Manager installed on the computer directly connected to a specific 
3‐D printer displays the queue and status for all jobs sent to that 3‐D 
printer by client computers on the network. It also allows editing and 
manipulation of all jobs, and enables re‐sending previously‐printed 
jobs to the printer.

Client Job Manager
When you open the client Objet Studio / Job Manager software for the first 
time, a dialog box opens prompting you to connect to an Objet server 
computer. To do this, the server computer must be operating and connected 
to the local network. 

Click Browse to find and select the name of the required server 
computer and then click OK to close the dialog box.

Figure 6-1: Server connection dialog box

To change the server-computer connection (to connect to another 
printer):

From the Job Manager screen, click the Connect icon   on the toolbar, 
or open the 3‐D Printer menu and select Set Printer.

If there are several printers on the local network, client computers can 
connect to any of them, but only one at a time.
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Job Manager 
Screen

On a client computer, Job Manager displays the queue of jobs sent by that 
computer to the printer server.

Figure 6-2: Client Job Manager screen

Information for each of the queued jobs is displayed, including the job 
status:

Print Queue

Print History

Status Meaning

Waiting Printing of this job has not started.

Building Printing of this job is in progress.

Paused Printing of this job began, but was interrupted by the 
administrator before being completed.

Stopped Printing of this job was terminated by the administrator, 
and was put in the print queue again.

Error Errors occurred during the printing of this job, and it was 
placed in the print queue again.

Editing This job is now being edited in Objet Studio.

Previewing The operator at the server computer is inspecting the 
model’s slices.

Spooling The job file is being spooled in the printer.

Preprocessing The 3‐D printer is readying itself for printing: the cover 
locks, print heads warm up and are put in starting 
position, UV lamps are turned on, build‐tray level is 
adjusted.
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Job Manager 
Operations

Even after sending a build tray to the 3‐D printer, you can inspect the tray—
and make changes to it, if necessary—as long as it is still in the print queue.

To inspect the build tray:
1. Select the job.
2. Click the Edit Job icon   or open the Job menu and select Edit.

Objet Studio opens, displaying the build tray. To make changes to it, see 
“Making changes to a Job” on page 10.

The following operations are available from the client Job Manager 
interface:

The 3‐D printer Status screen enables clients to monitor the progress of 
printing jobs. To display the screen, click the Machine Status icon  .

Icon Menu Option Purpose

3‐D Printer > 
New Job

Launches Objet Studio; to prepare new trays.

3‐D Printer > 
Set Printer

Displays a network‐browsing dialog box, to 
connect to an Objet server computer. To specify 
a computer, it must be operating and 
connected to the local network.

—— Displays the status of the 3‐D printer (see 
figure 6‐3).

3‐D Printer > Report Displays options for user messages and alerts 
(paper printer, e‐mail, SMS—see “Configuring 
User Alerts” on page 5).

Job > Delete... Removes the selected job from the queue.

Job > View… Opens a window displaying the selected tray. 
In this window, you can view the tray from 
different angles.

Job > Properties Opens a window displaying the properties of 
the selected model.

Job > Edit Launches Objet Studio and loads the current 
tray, to enable making changes to the tray after 
it is sent to the server but before it is printed.

Help > About... Displays the Job Manager version.
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Figure 6-3: Printer status screen 

Configuring 
User Alerts

Job Manager can alert you and others to the status of the jobs sent to the 
server for printing. The following events can be reported:
• The level of model or support material is low.
• The job was interrupted.
• The job was completed successfully.
To send messages, make sure that e‐mail software supporting MAPI is 
installed on the printer’s server computer. To send SMS messages, the 
e‐mail program must convert the messages and transmit them. Microsoft 
Outlook, for example, can do this; Outlook Express cannot. In addition, the 
cellular phone service must support the transmission of e‐mail messages by 
SMS. With SMS alerts, only the subject line of the e‐mail message is 
transmitted.

Note: In the e-mail program, make sure the security settings are set to 
“low” and add the server Job Manager to the “trusted” list (select 
Tools > Options, Security tab).

To configure Job Manager to send notifications and alerts for your jobs:
1. Click   or select Report from the 3‐D Printer menu.

The Preferences/Reports dialog box opens.

Figure 6-4: User alerts settings 
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2. For e‐mail and SMS alerts, click Add Recipient in the respective 
sections.

3. To choose the events reported to you by Job Manager, click Details in 
the relevant sections.

Figure 6-5: Event selection for alerts

4. Select the desired events for sending alerts and click OK.

The parameters for “Low level of material” alerts are set on the printer’s 
server computer.
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Server Job Manager
When you open the server Objet Studio / Job Manager for the first time, you 
are prompted to connect to an Objet 3‐D printer. To do this, the printer must 
be on and connected to the local network. If you click Yes, the Setting 
Network Connection dialog box opens. 

Figure 6-6: Printer connection dialog box

Click Browse to find and select the name of the computer inside the printer 
and then click OK to close the dialog box.

Job Manager 
Screen

On a server computer, Job Manager displays the queue of jobs sent to it by 
all client computers. In addition, it lists details of the last 15 jobs sent to the 
printer, and information about the job currently being printed.

Figure 6-7: Server Job Manager screen

Print Queue

Print History

Current Job
Info
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Print Queue
Information for each of the queued jobs is displayed, including the job 
status:

Job History
The History section of the Job Manager screen lists details of the last 15 jobs 
sent for printing, showing the job’s final status. A job can be returned from 
the History section to the print queue in order to print the tray again.

To move a job from History to the print queue:
1. Select the job in the History section.
2. Click the Resume icon  .

The job moves from the History section to the end of the print queue.
Note: Alternatively, you can drag the job from the History section to the 
print queue.

Status Meaning

Waiting Printing of this job has not started.

Building Printing of this job is in progress.

Paused Printing of this job began, but was interrupted by the 
administrator before being completed.

Stopped Printing of this job was previously terminated by the 
administrator, and later put in the print queue again.

Error Errors previously occurred during the printing of this job, 
and it was placed in the print queue again.

Editing This job is now being edited (with Objet Studio) on the Eden 
server computer.

Previewing The slices of this job are being displayed in a separate 
window. 
(To display the job tray, open the Job menu and select 
Preview Slices.)

Spooling The job file is being spooled in the Eden printer.

Preprocessing The Eden printer is readying itself for printing: the cover 
locks, print heads warm up and are put in starting position, 
the UV lamps are turned on, build‐tray level is adjusted.

To manipulate jobs in other ways, see “Job Manager Operations,” below.
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Job Manager 
Operations

The following table summarizes the main operations available from the 
server Job Manager interface. Many of the icons are active only if a job is 
selected. 

Icon Menu Option Purpose

3‐D Printer > 
New Job

Launches Objet Studio for preparing new trays.

3‐D Printer > 
Set Printer

Displays a network‐browsing dialog box, to 
connect to an Objet server computer. To specify 
a computer, it must be operating and 
connected to the local network.

3‐D Printer > 
Add Job...

Enables you to load previously‐saved jobs (otf 
files).

3‐D Printer > Report Displays options for user messages and alerts 
(paper printer, e‐mail, SMS—see “Configuring 
User Alerts” on page 5).

——— Moves the selected job to the head of the print 
queue.

——— Moves up the selected job by one step in the 
print queue.
Note: It is recommended that you group 
together jobs to be printed with the same type 
of model material. This way, the need for 
changing model material between jobs is 
reduced.

——— Moves down the selected job by one step in the 
print queue.

——— Moves the selected job to the end of the print 
queue.

Job > Restart Job For a stopped job in the print queue: Starts 
printing the selected job from the beginning. 
For a selected job in the History section: Moves 
the job to the print queue and changes its status 
to Waiting.

Job > Stop... Instructs the Eden printer to stop printing after 
curing the currently printed slice. (You can 
continue printing with the Resume icon or 
menu option, but for short interruptions, use 
the Pause icon or menu option.)

Job > Pause... Instructs the Eden printer to stop printing after 
curing the currently printed slice. (This 
command does not flush the printing buffer. 
Therefore, use it instead of Stop when you 
intend to continue printing the job shortly.)

Job > Resume Continues printing the current job after 
printing was stopped with the Stop or Pause 
icon or menu option. 
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Making 
changes to a 
Job

From the job (“print”) queue of Job Manager, you can open jobs to make 
changes to them before printing.

To make changes to a job:
1. Select the job in the print queue.
2. Click the Edit Job icon   or open the Job menu and select Edit.

Objet Studio opens, displaying the build tray. (The status of the job in 
Job Manager changes from “Waiting” to “Editing.”)

3. Make changes to the build tray in Objet Studio (see chapter 5, “Using 
Objet Studio”).

4. In Objet Studio, save the changes by selecting File > Save Tray (or by 
pressing Ctrl+S).

5. Close Objet Studio.
The status of the job in Job Manager changes back to “Waiting.”

Job > Delete Job... Removes the selected job from the queue.

Job > Review Job… Opens a window displaying the selected tray. 
In this window, you can view the tray from 
different angles.

Job > Job Info… Opens a window displaying the properties of 
the selected model.

Job > Edit Job… Launches Objet Studio and loads the selected 
tray, to enable making changes to it before 
being printed. (See “Making changes to a Job,” 
below.)

Help > About... Displays the Job Manager version.

Icon Menu Option Purpose
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User Alerts Job Manager can alert you and others to the status of the jobs sent to the 
server for printing. This is especially useful during long printing jobs, when 
the operator is away from the Eden 3‐D printer. The following events can be 
reported:
• The level of model or support material is low.
• The job was interrupted.
• The job was completed successfully.
For details on how to configure alert messages, see “Configuring User 
Alerts” on page 5.

To set parameters for “Low level of material” alerts:
1. From the 3‐D Printer menu, select Material Consumption….
2. In the dialog box that opens, set the time or the material weight 

remaining that triggers the alert message.

Figure 6-8: Material alert message dialog box

The dialog box shown above also pops up over the Job Manager screen to 
alert the operator that there is not enough material loaded in the printer to 
complete the current job. As long as this condition exists, a warning icon 
appears in the lower‐right corner of the Job Manager screen (when the 
status bar is visible). 

Note: If the status bar is not visible, select it from the View menu.)
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Figure 6-9: Insufficient material warning

When the time set in the dialog box triggers the remote alert message, the 
warning icon changes color—from a yellow to a red background.

Sending the 
Tray to the 3-D 
printer for 
Production

If there is a job in the print queue, it is sent automatically to the Eden 
printer—as long as it is on, there is a connection to the printer, and the 
printer is on line. Chapter 7 describes starting and operating the Eden 
printer.

Material 
warning 
icon
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Figure 7-1: The Eden500 3-D Printer

Starting the Eden500V/350V/350 3-D Printer

1. Turn on the main power switch, located at the back of the Eden printer.

Figure 7-2: Main power cable and switch

The main power switch turns on the Eden printer, which includes the 
built‐in Eden computer. 

2. After the computer boots, log in to Windows and launch the Eden 
control software:
• On the computer desktop, double‐click the Eden printer icon.

Printer cover

Printing-materials &
storage compartment

CAUTION!
• Do not attempt to operate the Eden printer before being trained by an 

Objet customer-support representative.
• Observe all safety warnings and follow the safety guidelines described 

in chapter 2.



DOC-00500 Rev. F 7–3

Eden500V/350V/350 User Guide

or—
• From the Start menu, select Objet > Eden500/Eden350V/Eden350.

The Eden printer interface screen opens (see figure 7‐3). All monitoring and 
controlling of the Eden printer is done from this interface.

Figure 7-3: Eden500 interface

Loading Model and Support Cartridges
The Eden350 printer uses one cartridge of model material and one cartridge 
of support material, each weighing 3.6 kilograms when full. Eden500V and 
Eden350V printers are equipped to be loaded with two cartridges of each 
type. This lets you print longer without changing cartridges and allows you 
to easily replace empty cartridges during prolonged printing operations. A 
graphical representation of the cartridges and their current weight appears 
in the Eden printer interface (see figure 7‐3).

To load model and support cartridges:
1. On the front of the Eden printer (see figure 7‐1), pull open the doors of 

the storage compartment.
2. If you are replacing a cartridge, grasp its handle and pull the cartridge 

out, taking care not to twist or turn it. 

Printer mode Current activity

Support material
cartridges

Display 
toggle button

Pause buttonStop button

Online/offline 
button

Model material 
cartridges

Eden installations utilize one monitor for displaying both the computer 
running Objet Studio / Job Manager and the computer installed inside the 
printer. Make sure that the KVM (keyboard-video-mouse) switch is in the 
correct position so that the Eden printer interface is displayed.

If you need to replace the model material currently installed with another 
type, see “Changing the Model Material” on page 8. Otherwise, make sure 
to replace the model cartridge with one containing the same type of 
material.
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3. Insert model and support cartridges in their respective compartments 
—the model cartridge on the right, and the support cartridge on the 
left. (Note that the cartridges only fit into their correct compartments.)
You should feel some resistance, as a needle pierces the cartridge. 

4. Check the Eden printer interface to make sure that the new cartridge is 
detected and that its weight is displayed (see figure 7‐3).

5. Close the storage compartment door.

Producing Models 
Before beginning to produce models, it is recommended that you check the 
current printing quality of the print heads by performing a pattern test (see 
“Pattern Test” on page 19). 

To prepare the Eden printer for producing models:
1. Make sure that the build tray in the Eden printer is empty and clean. If 

not, remove old material with the scraper, and clean the tray 
thoroughly with cleaning fluid.
Note: Use protective gloves when cleaning the build tray, and be careful of 
the sharp edges of the scraper blade.

2. Make sure that there is sufficient model and support material loaded 
in the printer, as indicated in the Eden printer interface (see figure 7‐3). 
You may want to replace the cartridges of model and support material 
currently loaded in the printer to avoid the need for replacing them 
during printing. 
• For installing material cartridges and replacing empty ones, see 

“Loading Model and Support Cartridges” on page 3. 
• For changing the type of model material currently loaded, see 

“Changing the Model Material” on page 8.
3. At the bottom of the Eden printer interface, click the red button to 

switch the printer to online mode (see figure 7‐3).
The color of the button changes from red to green. If there is a job in the 
Job Manager queue, it is sent (in slices) to the Eden printer. On the Eden 
printer interface, the printer mode changes from Idle to Pre‐print, as the 
printer’s components prepare themselves for production: 
• The print block is heated.
• The UV lamps are powered and they warm up.

Tips about replacing cartridges:

• You can replace material cartridges either before or during printing. 
• You can replace partially used cartridges to avoid the need for replacing 

them during printing.
• You can load partially used cartridges, as long as they contain more 

than 100 grams of material.

You can monitor printer status indicators by switching the Eden printer 
interface display. To do this, click the display toggle button in the printer 
interface.
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Figure 7-4: Eden printer indicators

Printer 
Interface 
Color Key

The background colors in the printer indicator fields tell you at a glance 
whether or not the value or item is suitable or ready for printing. 
• Green—suitable/ready for printing

For example, in figure 7‐4:
Ambient—The ambient temperature of the printing chamber is 
within the acceptable range.
Heads Liquid—The level of model and support material in the print‐
block reservoir is OK.
Heads Vacuum—The vacuum level in the system is within the 
acceptable range.
Pre‐Heater—The model and support resins need to be heated before 
being supplied to the print block. The temperature has reached the 
acceptable range.

• Red—not suitable for printing (or indicates a warning)
For example, in figure 7‐4: 
Waste—The weight of the waste container is 9000 grams, more than 
allowed when beginning a print job. (See “Replacing the Waste 
Container” on page 47.)

• Blue—not ready for printing
For example, in figure 7‐4:
UV lamps—The UV lamps are not on (or not operating at full power).
Heads (°C)—The heads have not reached the temperature required 
for printing models.

Block temp.
in front of

support heads

Block temp.
behind

support heads

Waste weight

Display 
toggle button

Printer set to 
online mode 
(green)

Temp. of each
support head

Chamber temp.

Left UV lamp

Right UV lamp

Block temp. 
behind 
model heads

Temp. of each 
model head

Block temp. 
in front of 
model heads
Support/Model 
material in print- 
block reservoir
System 
vacuum level
Pre-heating of 
support & model 
material
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Printing 
Indicators

When the printer is ready, the main interface screen changes (see 
figure 7‐5):
• The mode changes from Pre‐print to Printing. 
• The specific activity being performed is shown in the “current activity” 

field. 
• Current job‐printing information is displayed.
• The printing progress bar is displayed.
• The Stop and Pause buttons are enabled.

Figure 7-5: Eden printer interface during printing 

When printing begins, Job Manager sends seven slices to the Eden printer. 
This is the standard buffer between the Job Manager and the printer. As 
each slice is printed, the Job Manager sends another slice to the printer.
Depending on the size of the model(s) to be produced, printing can take 
between several hours to several days. As long as there is enough model 
and support material in the supply cartridges, printing proceeds 
automatically until the job is finished.

Resuming Production After Printing has Stopped
If the printing process is interrupted for any reason, Job Manager stops 
sending slices to the Eden printer.

To continue printing the model:
1. Switch the printer to online mode by clicking the red button at the 

bottom of the Eden printer interface (see figure 7‐3 on page 3).
The button changes from red to green (see figure 7‐4 on page 5).

Current Activity

Job information

Progress bar

Pause buttonStop button

Printer mode

Job information

During printing, the server computer must remain on and it must 
communicate with the Eden printer. Do not log-off Windows until printing is 
finished.
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2. Make sure that the computer network connecting the printer and Job 
Manager server is active.

3. In the Job Manager interface, click the Resume icon  .
4. In the Continue from Slice dialog box that appears, confirm the slice 

number, after checking the Eden printer interface.

Figure 7-6: Eden printer interface after interrupted printing

Figure 7-7: Continue from Slice confirmation dialog box in server 
(Job Manager) interface

5. If, for any reason, the correct number does not appear in the dialog 
box, enter the number and click OK.

You cannot continue printing the model if:
• The number of the last slice printed does not appear in the Eden printer 

interface, even if the server computer displays the Continue from Slice 
confirmation dialog box.

• There was a relatively long interruption in printing, even if the “last 
slice” and “continue from slice” indicators are correct. The part of the 
model already printed may deform or shrink, and there might be a 
visible difference between it and the newly printed part. The effects of a 
printing stoppage on a model depend on the model size and structure, 
model material used, ambient temperature and the length of the 
stoppage.

If you cannot continue printing: 
1. Cancel the print job in Job Manager. 
2. Remove the partially printed model from the build tray. 
3. Send the job to the Eden printer again.

Printer mode

Last slice 
printed

You can stop and later resume printing from either the Eden printer interface 
or the Job Manager interface, since both applications are updated when you 
use these commands. However, after clicking the Pause button in the 
printer interface, you can only resume printing from the printer interface.
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Changing the Model Material
Before producing models using a different type of model material (resin) 
than is currently installed, you must flush the print block and feed tubes by 
running the Resin Replacement wizard.

To replace the model material:
1. Start the Resin Replacement wizard, either from the Wizards tab (on the 

right side of the Eden interface) or from the Options menu.

Figure 7-8: Starting the Resin Replacement wizard from the Wizards tab

Figure 7-9: Starting the Resin Replacement wizard from the Options menu

2. From the opening screen, click Next to display the Resin Selection 
screen.
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3. If the printer cover is not closed, a screen appears, instructing you to 
close the cover. Confirm that it is closed and click Next.

4. From the drop‐down menu, choose the type of model material (resin) 
you want to install, and click Next.

Figure 7-10: Resin Selection screen

Note: This selection automatically affects the default material setting in 
Objet Studio.

5. For Eden500V and Eden350V printers only—
Select an option for changing the resin type for either model cartridge 
or for both cartridges, and click Next.

Figure 7-11: Cartridge-replacement options screen
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6. In the Resin Replacement Cycle screen (see figure 7‐12), choose the 
appropriate cycle for the model material you want to install. With two 
of the options, the print block is flushed with the new model material. 
With the third option, the print block is flushed with cleaning fluid 
before it is filled with the new model material. 
Flushing the block with model material:

• Short Cycle. During this cycle, which takes about 30 minutes, the 
pump purges the model material from the print block, then flushes 
the system with the new material.
Since traces of the previous material may be present in the first 
models printed with the new material, this cycle is usually 
acceptable when replacing a light‐colored model material with a 
darker material (such as TangoBlack™ or VeroBlack™), or if the 
color of the printed models is unimportant.

• Double Short Cycle. During this cycle, which takes about 50 minutes, 
the wizard cleans the feed tubes and print block more thoroughly 
by flushing the system twice with the new material.
This cycle is used when replacing a dark‐colored model material 
(such as TangoBlack or VeroBlack) with a lighter material.
Flushing the block with cleaning fluid:

• Long Cycle. During this cycle, which takes about 60 minutes, the 
wizard cleans the tube and print block very thoroughly by flushing 
the system with cleaning fluid before filling the block with the new 
material.
This cycle is used when replacing a dark‐colored model material 
(such as TangoBlack or VeroBlack) with a lighter material. Using 
cleaning material is recommended over cleaning the system with 
model material, since it is more effective and economical. However, 
you must be present during the process to change the cartridges of 
cleaning fluid and model material. 

Figure 7-12: Resin Replacement Cycle screen
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7. Click Next, and take note of the warning screen.

Figure 7-13: Resin Material Replacement warning screen

8. To continue, click Next.
9. When prompted by the wizard screen, remove the model‐material 

cartridge(s). Select the check box to confirm that you have done so, and 
click Next.

10. When prompted, insert the new cartridge(s) of model material. Select 
the check box and click Next.

Figure 7-14: Prompt to insert new right-hand model cartridge

Once you start this procedure, you must complete it before you can produce 
models with the Eden printer. To perform the procedure at another time, 
click Cancel. If you continue (by clicking Next) and you do not complete the 
procedure, you must start the Resin Replacement wizard again (see step 1 
on page 8) before producing models. 
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The Eden printer begins the process of filling the print heads with the 
new model material. This may take up to 15 minutes.

Figure 7-15: Resin replacement: filling heads with new model material

11. When the final wizard screen appears, click Done to close the wizard.

CAUTION: Dispose of cartridges of Eden model and support material in 
accordance with all applicable laws and regulations. If necessary, the 
cartridges can be disassembled for recycling. If this is done, protect the 
person handling the cartridges from direct exposure to uncured resins.
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Keeping the Eden 3-D Printer in Idle Mode
Between printing jobs, the Eden 3‐D printer can be kept on for up to one 
week. If the printer will not be used for more than a week, use the 
shutdown wizard to automatically perform the procedures that must be 
done before turning off the printer (see “Shutting Down the Eden 3‐D 
Printer,” below).
When the Eden 3‐D printer stops producing models, the printer software 
automatically reduces the temperature of the print heads as follows:

Note: The printer mode is indicated in the green field on the left of the 
interface (see figures 7-3, 7-4 and 7-5 on pages 3, 5 and 6).

If, after printing a job, you know that the printer will not be used for 10 
hours or more, you can immediately turn off the heating of the print heads 
by putting the printer into Idle mode.

To put the printer into Idle mode:
From the File menu (in the printer interface) click Exit.

Note: The printer remains in Idle mode until you open the Eden printer 
application and begin printing again.

Time after printing Mode Change in heating of print heads

first 15 minutes Standby 1 none

next 10 hours Standby 2 heating reduced (to room temp.)

after 10 hours Idle heating stopped

When the printer is in Idle mode, do not turn it off. It can remain in this 
mode—with the cover closed—for up to a week. For longer periods, shut 
down the printer by running the Shutdown wizard (see below). 
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Shutting Down the Eden 3-D Printer
You only need to shut down the Eden 3‐D printer if it will not be used for a 
week or more. To properly shut down, the printer needs to perform several 
processes. These are controlled by the Shutdown wizard. Always use this 
wizard, instead of just closing the Eden printer interface.

To run the Eden Shutdown wizard:
1. Select Shutdown from the Options menu, or press F8.

Figure 7-16: Shutdown wizard, opening dialog box

2. In the opening dialog box, click Next.
3. In the next wizard screen, indicate whether or not the tray is empty 

and click Next.

Figure 7-17: Tray status screen
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The shutdown procedure begins.

Figure 7-17: Shutdown Sequence screen

The Shutdown procedure may take up to 10 minutes while the 
following tasks are performed:
a. The print block returns to its starting point on all axes.
b. The print heads are heated.
c. The print heads are cleared of any remaining material.
After these tasks are completed, the final wizard dialog box appears, in 
which you choose whether or not to shutdown the computer in the 
Eden printer.

Figure 7-18: Computer Shutdown confirmation dialog box

4. When completely shutting down the Eden printer and turning the 
power off, select Yes and click Next.

5. After the printer computer shuts down, turn off the main power switch 
(at the back of the printer—see figure 7‐2 on page 2).
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Maintaining Eden 3-D Printers
The performance of routine maintenance tasks is essential to getting 
satisfactory results from Eden 3‐D printers. Perform the tasks at specified 
intervals for optimum performance.

Routine 
Maintenance 
Schedule

 

Cleaning the 
Print Heads

Periodic inspection and cleaning of the orifice plates on the bottom of the 
print block ensures that the print nozzles are not blocked. A wizard guides 
you through the procedure, and adjusts components of the Eden printer to 
enable you to perform it. This procedure takes about 20 minutes, and 
should be done at the beginning of the work day or before a big printing 
job.

To clean the print heads:
1. Prepare—

• isopropanol (IPA—isopropyl alcohol) or ethanol (ethyl alcohol)
• disposable cleaning gloves
• an Objet‐supplied cleaning cloth or equivalent
• a mirror

2. Start the Heads Cleaning wizard, either from the Wizards tab (on the 
right side of the printer interface) or from the Options menu (see 
figure 7‐25 on page 21).

Frequency Task For More Information

Daily, before printing Clean the print heads. See “Cleaning the Print 
Heads,” below.

Weekly Perform the Pattern test. See “Pattern Test” on 
page 19.

Weekly Clean and inspect the 
wiper.

See “Cleaning and 
Replacing the Wiper” 
on page 20.

Weekly Clean the build tray and 
the surrounding area.

Weekly Restart the Eden printer 
computer and the server 
computer.

Monthly, and after 
replacing print heads

Check the alignment of 
the print heads.

See “Aligning the Print 
Heads” on page 23.

Monthly Clean the roller waste 
collector.

Monthly Inspect the exhaust 
system (duct, fan, 
connections).

Every 2000 hours of 
printing or once a year

Preventive maintenance 
by authorized service 
engineer.

Contact your Objet 
support center.

At least once a year Replace the activated 
carbon odor filter.

Contact your Objet 
support center.
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3. Follow the instructions on the wizard screens, and select the check 
boxes to confirm that:
• you have checked that the tray is empty.
• you have closed the cover.

Figure 7-19: Head cleaning procedure—wizard screen

4. Click Next. 
The printer prepares for you to clean the print heads.

5. When the following screen appears, open the cover.

Figure 7-20: Head cleaning wizard—steps 5–10

6. Place the mirror on the build tray.
7. Put on the gloves.
8. Soak the cleaning cloth with the cleaning fluid.
9. Clean the orifice plates, with a back‐and‐forth motion (see figure 7‐21). 

Use the mirror to make sure that you have removed all of the residue 
material.

WARNING:  The print head orifice plates (bottom surface) may be hot. 
Do not touch them with your bare hands, and proceed with caution.
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Figure 7-21: Cleaning the heads

10. When you have finished cleaning, select the confirmation check box in 
the wizard screen (see figure 7‐20) and click Next.

11. Remove the cleaning materials from the printer and close the cover. 
12. Select the confirmation check boxes in the wizard screen and click 

Next.
The head‐purge cycle begins. When this is complete, the final wizard 
screen appears.

Figure 7-22: Head cleaning wizard—final screen

13. Click Done to close the wizard.

It is recommended that you use this opportunity to also clean the roller and 
the UV-lamp lens (to the right of the print heads).
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Pattern Test The pattern test is the basic verification of the printer’s ability to produce 
quality models, since it demonstrates the condition of the nozzles in the 
print heads. Make sure, therefore, that you perform this test weekly, and 
whenever you suspect a printing problem.

To perform the pattern test:
1. Make sure that the build tray is empty.
2. Prepare a sheet of pink paper—A‐4 or Letter size.
3. In the Eden printer, tape the pink paper to the surface left of the build 

tray.
4. In the Eden computer interface, open the Options menu and select 

Pattern Test, or press F3.
5. In the Confirm dialog box, click Yes.

Figure 7-23: Pattern test confirmation

The Eden printer prints a series of lines on the test paper.

Figure 7-24: Sample Pattern Test

6. Carefully inspect the test paper to see if there are missing lines. 
Too many missing lines, especially if they are in the same area, is an 
indication that the quality of printing when producing models will be 
poor. If this is the case, see “Improving Print Quality,” below.
Note: Acceptable model quality is subjective, and depends on the type 
and scale (size) of the models produced. As a rule, however, more than 15 
missing lines in one area of a column is considered unacceptable.
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Improving 
Print Quality

If you suspect that print quality is poor, perform the pattern test (see 
“Pattern Test” on page 19). If the results are poor, use the following 
procedure to improve print quality.

If the results of the last pattern test are poor:
1. From the Options menu, select Execute Purge Sequence, or press F4.
2. In the confirmation dialog box, click Yes.

The print heads are purged of model and support material, and the 
wiper removes excess material from them.

3. Repeat the purge sequence.
4. Perform the pattern test.

If the results of the pattern test are still poor:
1. Manually clean the print heads (see “Cleaning the Print Heads” on 

page 16).
2. Perform the purge sequence.
3. Perform the pattern test.

If the results of the pattern test are still poor:
1. Carefully clean the print heads again, making sure there is no residue 

left on them.
2. Perform the purge sequence.
3. Perform the pattern test.

If the results of the pattern test are still poor:
Replace faulty print heads (see “Replacing Print Heads” on page 27).

Cleaning and 
Replacing the 
Wiper

A rubber wiper blade removes excess material from the print heads after 
the purge sequence. This is done automatically before each print job, and 
performed manually during maintenance tasks. You should clean the 
wiper and surrounding area at least once a week. If the wiper is damaged 
or worn, replace it. In any case, replace the wiper at least once a month.

To inspect and clean the wiper:
1. Prepare—

• isopropanol (IPA—isopropyl alcohol) or ethanol (ethyl alcohol)
• disposable cleaning gloves
• an Objet‐supplied cleaning cloth or equivalent
• a spare wiper blade
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2. Start the Wiper Cleaning wizard, either from the Wizards tab (on the 
right side of the printer interface) or from the Options menu.

Figure 7-25: Starting the Wiper Cleaning wizard

3. Close the Eden printer cover, and click Next in the wizard screen.
4. Follow the instructions on the wizard screens, and select the check 

boxes to confirm that:
• you have checked that the tray is empty.
• you have closed the cover.

Figure 7-26: Wiper Cleaning procedure—step 4

5. Click Next. 
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6. When the following screen appears, open the cover.

Figure 7-27: Wiper Cleaning procedure—steps 7–10

7. Put on the cleaning glove.
8. Using a generous amount of cleaning fluid and the cleaning cloth, 

remove any material remaining on the wiper and the surrounding 
area.

9. Inspect the wiper blade. 
If the wiper blade is scratched, torn or worn, or if you cannot clean it 
completely, replace it.
a. Grasp it and pull it up and out of its bracket. 
b. Insert the new wiper blade, making sure that it is straight and secured 
well on both sides.

10. In the wizard screen (“Is wiper clean?”), select the confirmation check 
box (see figure 7‐27) and click Next.

11. Make sure that you have removed all tools and cleaning materials 
from the printer, and close the cover. 

12. Select the confirmation check boxes in the wizard screen and click 
Next.

13. Click Done to close the wizard.
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Aligning the 
Print Heads

You should check the alignment of the print heads— 
• once a month
• after replacing one or more heads
• if model quality is not acceptable even after cleaning the orifice plate on 

the bottom of the print block (see “Cleaning the Print Heads” on 
page 16)

The head‐alignment procedure takes about 20 minutes.

To check the alignment of the print heads:
1. Prepare—

• a transparency sheet—A‐4 or Letter size
• any type of sticky tape, to fasten the transparency sheet to the build 

tray
2. Start the Head Alignment wizard, either from the Wizards tab (on the 

right side of the Eden interface) or from the Eden Options menu (see 
figure 7‐25 on page 21).

3. Click Next to begin, and close the cover.
4. In the wizard screen, select the check box to confirm that the cover is 

closed, and click Next.
5. When instructed to do so, place the transparency on the build tray— 

next to the left and rear edges of the tray, as shown in the following 
figure.

Figure 7-28: Positioning the transparency on the build tray

6. Make sure that the transparency sheet is lying flat, and tape it to the 
tray.

7. In the wizard screen, select the check box to confirm that the 
transparency sheet is on the build tray, and click Next.
The Eden printer prints the head alignment test on the transparency.
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8. When the following screen appears, remove the transparency.

Figure 7-29: Head Alignment wizard—steps 8–10

The transparency sheet is printed with sets of vertical lines in seven 
columns, each showing the results from a different print head. 

Figure 7-30: Sample head-alignment test

• The three columns on the right were printed by the heads used for 
applying model material when producing models. From right to 
left, the columns represent heads M1, M2, M3, respectively. (There 
is no column for head M0 because its alignment is used as a 
reference for aligning all other heads.)

• The four columns of lines on the left were printed by the heads used 
for applying support material. The columns represent heads S3, S2, 
S1 and S0, respectively.
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9. For each column of lines, use a magnifying glass or loupe to inspect 
pairs of consecutive rows printed on the transparency to see where the 
vertical lines align.

Figure 7-31: Comparing rows of alignment lines

Note: It does not matter which pair of lines you inspect, since they were all 
printed by the same head. Choose a pair of clearly printed lines for the 
inspection. (Since some nozzles may not print clearly, you may have to 
inspect several pairs of lines to properly inspect the alignment.)
Optimum head alignment is shown when the fourth lines in the upper 
and lower rows are aligned, as in figure 7‐31. In the example shown, no 
change to the head alignment is necessary. If other lines in the set are 
aligned, you need to change the alignment of that head—in the next 
wizard screens.

10. In the wizard screen shown in figure 7‐29, select the Transparency 
removed check box, and click Next.
The first in a series of alignment screens appears.

Figure 7-32: Head alignment screen

11. In the head‐alignment screen, select the number that indicates which 
lines align in the upper and lower rows of a pair on the transparency 
(counting from the left) for this print head.
Note: Because the alignment of the fourth lines is optimum, the number “4” 
is selected, by default, in the wizard screen. This does not change the head 
alignment. If you select other numbers, the wizard adjusts the head 
alignment, accordingly.

12. Click Next to display the next head alignment screen, and again select 
the number representing the most closely aligned vertical lines on the 
transparency for that print head.

Alignment-line 
numbering, left-to-right

Row pairs
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When you have finished aligning all of the heads, the following screen 
is displayed.

Figure 7-33: Updating System Parameters confirmation screen 

13. Choose one of the following to continue:
• To make the alignment changes in the printer, make sure that Yes is 

selected, and click Next.
• To recheck the alignment test results before making the alignment 

changes in the printer, click Previous.
• If you do not want to make alignment changes in the printer at this 

time, select No and click Next.
14. In the final wizard screen, choose to either repeat the head alignment 

procedure or close the wizard. 
• If the most closely aligned vertical lines for a print head were at 

either extreme—the first or seventh lines—choose Yes to run the 
head‐alignment wizard again, then click Next. 
The transparency test will show if the heads are now properly 
aligned, and—if not—the wizard will allow you to “fine tune” the 
alignment.

• If the vertical lines for the print heads were not aligned at either 
extreme, choose No to close the wizard, then click Next.

Figure 7-34: Final head alignment screen
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Replacing 
Print Heads

You need to replace a print head if one or more of the following symptoms 
occurs:
• The pattern test reveals that more than 15 nozzles are not functioning in 

one area of the head.
• Visual inspection reveals that the surface of the head is damaged—

peeling or bubbles in the nozzle area.
• The Eden interface displays a warning or malfunction message relating 

to a print head—
Head Heater temperature timeout
Head Heater thermistor open
Head Heater thermistor short

• Tests reveal that the material printed by a print head is underweight 
(that is, not enough material is being outputted).
Note: Weight tests are performed only by an authorized service engineer.

A wizard guides you through the procedure of replacing a print head, and 
adjusts components of the Eden printer to enable you to perform it. Only 
replace a print head with the aid of the wizard. The procedure takes 75—90 
minutes, and consists of the following phases: 
A. Identifying the head(s) needing replacement. 

This is usually done by examining the results of the pattern test, after 
attempting all other means for improving print quality (see 
“Improving Print Quality” on page 20). Otherwise, evidence of 
physical damage to the head surface or a malfunction message 
indicates which head needs replacing.

B. Preparing the print block for head replacement.
This is done automatically when you run the Head Replacement wizard.

C. Removing the defective print head. 
D. Installing a new print head.
E. Performing weight calibration.

The wizard prints a sample. After weighing it on a scale, you enter the 
weight in the wizard dialog box.

F. Performing head alignment.

Replacing print heads is expensive. Replace them only after consulting with 
Objet customer support to determine that head replacement is necessary.
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To replace a print head:
1. Prepare—

• replacement print head(s)
• isopropanol (IPA—isopropyl alcohol) or ethanol (ethyl alcohol)
• disposable safety gloves (included in the head replacement kit)
• an Objet‐supplied cleaning cloth or equivalent
• a flat‐head screwdriver (5 mm)
• the scale supplied by Objet for use in the weight test
Note: Make sure that you have these items before running the Head 
Replacement wizard.

2. Start the Head Replacement wizard, either from the Wizards tab (on the 
right side of the Eden interface) or from the Options menu (see 
figure 7‐25 on page 21).

3. In the opening wizard screen, click Next to begin.
The Head Replacement Conditions screen appears.

4. Read the conditions, select I Agree and click Next.
Preparing the

print block
5. Select the print head(s) needing replacement, and click Next.

Figure 7-35: Head selection screen

The Eden printer heats and empties the print block. (This should take 
about 10 minutes.)

Figure 7-36: Emptying Block progress screen
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When the print block is completely drained, the wizard wipes the 
heads. Then, the following warning screen appears.

Figure 7-37: Head Replacement warning screen

6. Select the Open door check box and click Next if you are ready to 
continue.

7. Open the Single Head Replacement kit, and remove the safety gloves 
and the instructions.

8. Put on the safety gloves.
9. When the following screen is displayed, open the Eden printer cover.

Note: The Eden printer disconnects power to the heads for your safety.

Figure 7-38: Replace the defective head when this screen appears
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Removing the
Defective Head

10. On the print block, release the upper and lower screws that secure the 
print head in the block. (If necessary, you may use a screwdriver to 
loosen the screws.)

Figure 7-39: Releasing the locking screws

11. Press down on the upper and lower locking screws to release the print 
head.

Figure 7-40: Releasing the print head

12. Loosen the screws on the door of the compartment protecting the 
print‐head driver cards (A), then pull and lift up the door (B).

Figure 7-41: Opening the print-head compartment
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13. Pull the print‐head driver card out of its socket so that the head is free 
(A), and remove it from the bottom of the print block (B).

Figure 7-42: Releasing the print-head driver card to remove the head

14. Make sure that along with the head, you remove the two rubber O‐ring 
seals.

Figure 7-43: O-ring seals on the print head

Figure 7-44: Making sure the O-rings are not stuck to the print block

Important: If the seals are not removed with the head, they are probably 
stuck to the print block housing. If so, remove them.
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Installing the
New Head

15. Inspect the replacement head, and make sure that the O‐ring seals are 
in place (see figure 7‐43).

16. Gently insert the replacement head into the vacant slot in the print 
block, and push the print‐head driver card into its socket.
Note: Make sure to insert the head with driver card facing its socket, in the 
rear of the print block.

Figure 7-45: Inserting the print-head driver card into its socket

17. Push the head up until you hear it click into place, in both front and 
rear holders.

Figure 7-46: Clicking the head into place in the print block

18. Lower the door of the print head compartment, and tighten the screws 
to lock it in place.

19. Tighten the upper and lower screws that secure the print head in the 
print block (see figure 7‐39 on page 30).
Note: Hand-tighten these screws. Do not use a screwdriver.

20. In the Replace Head Now dialog box (see figure 7‐38 on page 29), 
select the check box to confirm that you have replaced the head, and 
click Next.
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21. With your fingers, make sure that the new head is level and even with 
the other heads.

Figure 7-47: Checking the level of the new head

22. Confirm that the heads are level and even by selecting the check box in 
the next wizard screen, and click Next.

Figure 7-48: Installation-check screen

23. In the next wizard screen, select the check box to confirm that you have 
removed all tools and objects from the printer.

Figure 7-49: Cleared-tray confirmation screen

24. Close the printer cover.
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The wizard continues by filling the heads, then heating and purging 
them. If there are no installation problems, the weight calibration 
procedure begins (see “Weight Calibration” on page 35).
If a vacuum leakage is detected, or if there are other problems, the 
wizard alerts you and instructs you how to continue (see “Installation 
Problems,” below).

Installation
Problems

• If the printer software does not sense the replaced head, the following 
warning screen appears. 

Figure 7-50: Incorrect-installation screen, showing which head(s) to re-insert

If this happens: 
a. Open the print head compartment (see figure 7‐41 on page 30).
b. Re‐insert the print‐head driver card into its socket (see figure 7‐45 

on page 32).
c. In the wizard screen, select the check box to confirm that you have 

re‐inserted the card, and click Next.

• If the replacement head was not factory‐calibrated, the following 
warning screen appears. 

Figure 7-51: “No factory data” warning screen

If this happens: 
a. Remove the head and replace it with another one (starting with step 

10 on page 30).
b. In the wizard screen, select the check box to confirm that you have 

installed another print head, and click Next.
c. Contact Objet customer support about the uncalibrated head.
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• If the vacuum test is not successful, the replacement head was not 
sealed properly during installation, and the following warning screen 
appears.

Figure 7-52: Vacuum Leakage warning screen

If this happens: 
a. Click Next.
b. Follow the instructions on the wizard screens to re‐install the head.

Weight Calibration After the successful installation of print heads, the wizard begins the 
first of two weight tests, in which each head prints a sample. Each test 
takes 15–25 minutes.
Note: For Eden350 printers, only one weight test is performed (for High 
Quality mode). For other Eden printers (including Eden350V models), two 
weight tests are performed (for High Quality and High Speed modes).

25. When the following screen appears, click Next to start the weight test.

Figure 7-53: Starting the weight test
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Figure 7-54: High-speed-printing weight test screens

26. Carefully remove the samples for each head, keeping track of the head 
that printed them.

 
Figure 7-55: Samples printed on the Eden printer build tray

27. Using the scale, weigh each sample and enter the weight (in grams) for 
the corresponding head in the wizard screen. Then click Next.

Figure 7-56: Weight Test data entry screen

After the first weight test, the printer calibrates the heads for this mode, 
prepares for the next weight test, and prints more samples (except for 
Eden350 printers).

28. Remove and weigh the samples and enter the data, as before (see steps 
26 and 27). Then click Next.
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After the Eden printer calibrates itself for this mode, the final wizard 
screen appears.

Figure 7-57: Final Head Replacement screen

29. After replacing print heads, you should check the head alignment 
before using the Eden printer to produce models. 
• Select Yes and click Done to open the Head Alignment wizard (see 

“Aligning the Print Heads” on page 23). 
• Select No and click Done to align the heads at another time.

Replacing the 
UV Lamps

The UV lamps used for curing models have a long, but limited, working 
life. The Objet service engineer tests their effectiveness during regular 
maintenance checks, and replaces them, if necessary. If, for any reason, you 
need to replace a UV lamp, follow these instructions. 
1. Make sure the Eden printer is in offline mode.

Figure 7-58: Offline mode indicator (red)

The online/offline button at the bottom of the printer interface should be 
red. If not, click it to switch the printer to offline mode.

2. Open the cover of the Eden printer.
3. Start the UV Lamp Replacement wizard. 

• From the Options menu of the printer interface (see figure 7‐25 on 
page 21), select Wizards > UV Lamp Replacement.

WARNING:  Before continuing, make sure that the safety interlock in the 
printer cover is not defeated, and that the lamp is not hot.
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4. Make sure that the build tray is empty. In the wizard screen, confirm 
this and click Next.

Figure 7-59: “Empty tray” confirmation screen

5. Select the UV lamp(s) to be replaced and click Next.

Figure 7-60: UV lamp selection screen

6. Disconnect the power connection to the UV lamp.

Figure 7-61: Disconnecting power to the UV lamp 

Note: Do not disconnect the power connection to the cooling fans.
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7. Loosen the screw securing the UV lamp cover (A), and pull the cover 
up (B), then out (C).

Figure 7-62: Removing the UV lamp cover

8. Pull the lamp reflector out of the print block. 

Figure 7-63: Removing the UV lamp reflector

9. On the inside of the lamp reflector, a black strip covers part of the 
reflector. Remove this strip by sliding it off.

Figure 7-64: Removing the black strip from the old reflector

10. Discard the old reflector and lamp, but save the black strip so you can 
install it in the new reflector.
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11. Fasten the black strip to the inside of the new UV lamp reflector, on the 
same side as it was in the old reflector.

Figure 7-65: Fastening the black strip to the right UV lamp reflector

12. Insert the new UV lamp/reflector unit into the housing next to the print 
block.

Figure 7-66: Print block and UV lamp assembly, showing correct placement of 
black strip

Important: The black strip must always be on the side of the reflector 
opposite the print block.

Black strip

UV lamp 
assembly

Black strip

UV lamp
assembly
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13. Replace the lamp cover by inserting it into the slot on the bottom of the 
housing, and tighten the securing screw on top.

Figure 7-67: Replacing the lamp cover

14. Reconnect the power connection to the UV lamp.

Figure 7-68: Connecting power to the UV lamp

15. In the wizard screen, confirm that you have replaced the lamp(s) and 
attached the black strip, then click Next.

Figure 7-69: Installation confirmation screen
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The wizard operates the lamps and checks if their power is within the 
acceptable range for each printing mode. (The mode currently being 
checked appears in the lower‐left corner of the printer interface.)

Figure 7-70: Status screen during UV lamp check

16. When the final wizard screen appears, click Done.

Figure 7-71: Final wizard screen
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Built-in Tests The software that runs your Eden 3‐D printer contains a suite of tests for 
regularly checking the hardware and software, and for troubleshooting. 
You can configure basic communications and environment tests to run 
automatically, when the Eden software opens. In addition, you can run a 
more comprehensive set of tests before processing a print job, as a system 
check, to ensure optimum printing results. 
Because running the tests effects the operation of the printer, you can only 
open the Built‐in Tests interface when the Eden system is not printing.
The test suite features:
• The organization of printing‐related tasks in categories:

Communications 
Data cards 
Temperatures 
Voltages 
Encoder repeatability 
Print‐head heating
Print‐head filling 

• A clear display of test results and the source of any failures, enabling 
you to determine if printing is possible or worthwhile. 

• The ability to monitor test results for specific components.
• Troubleshooting tips.
Running these tests can help identify problems in the printer hardware and 
software. A large number of hardware defects (or near‐defects) warns you 
of possible printing problems, either for current or future jobs.

Accessing
Built-in Tests

To open the Built-in Tests screen, do one of the following: 
• From the Options menu, select Built-In Tests.
• Press Ctrl+Alt+B.

Figure 7-1: Selecting Built-In Tests from the Options Menu

Objet recommends running the built-in tests in the following cases:

• As a routine test, once every two weeks
• As a system check, before major (long) jobs
• As needed, for troubleshooting.
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Test Interface The Built In Tests screen lists pre‐configured tests, grouped by component 
categories. In this screen, you select and run tests, and the results are 
displayed.

Figure 7-2: Built In Tests screen

Test List Test Name
This column lists all of the tests, together with selection check boxes. 
Click the check boxes to select the tests you want to run. To remove a 
selection, click the check box again. To quickly select all of the tests in a 
component category, use the Group pull‐down menu at the bottom of the 
screen.

Group
This column shows the component categories for each test. 
This tells you which tests are run when selecting a category from the Group 
pull‐down menu at the bottom of the screen.

Status
This column shows the status of each test after you run it:

Test successfully completed.

Test failed. (Double‐click on a failed test’s line to review the failure 
details.)

Unknown results. (The test has not been run yet.)
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Test Selection Area In the Test Selection area, at the bottom of the screen, you can quickly select 
or de‐select tests by their characteristics:

Running Tests To run the selected tests:
Click the Run button.

Test Results To display the detailed results of any single test: 
Double‐click the name of the test in the list. 
The results are displayed in a separate window.

To save and view a report of all of the tests:
Use the Save and View command buttons (see below).

Command Buttons You click the command buttons, on the right side of the screen, to perform 
the following operations:

Run
Click to run the selected tests.

Reset
Click to clear previously run tests. This returns the status of each test to 
Unknown (?).

Save
Click to save a report that summarizes the tests run. The report is saved as 
an HTML file. You can save any number of reports for the tests you run; the 
name of the file saved is BITReport [date][time].htm. By default, these files 
are saved in the Eden installation folder, but you can save it in any other 
folder.

View
Click to display the latest test report that you saved. (You can view other 
test reports by opening the relevant files in your Web browser. To do so, 
open Windows Explorer, and double click the BITReport file.

Close
Click to close the Built‐in Tests screen.

All Click to select all of the tests in the list.

None Click to de‐select all of the tests in the list.

Unknown Click to select all test that have not been run yet (Status = ?).

Group Use this menu to select tests by component category.

Selection 
Set

Use this menu to select a pre‐configured set of tests to run at 
specified times (computer startup, before printing, etc.).
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Summary This area, on the right side of the screen, displays the combined results of 
all the tests run, using the symbols used in the Status column:

Test Descriptions
and

Troubleshooting

The following table lists the name of each test in the Built‐in Tests suite, 
together with its description and a possible reason for its failure. If you 
need assistance, contact your Object service provider.

All tests successfully completed.

At least one test failed.

Not all tests performed.

Test Name Description Possible Reason for Failure

Sub‐System 
Communication

Tests communications between 
Eden components.

Disconnected communications cable. 
Faulty cable.

FIFO Non‐Interrupt/
FIFO Interrupt

Tests the data queue in the DATA 
PCI card.

Faulty DATA_PCI card.

Encoder Tests the encoderʹs reliability by 
comparing readings from multiple 
runs along the X‐axis.

Faulty encoder.

System Info Compares the following parameter 
values with the minimum 
requirements.
• Physical memory

• Available memory

• Free space on disk

• Monitor resolution

Failure of RAM memory allocation in 
the Eden computer.

Block Filling Analyzes the thermistor readings 
when the block is full and when it is 
empty.

Faulty thermistor.

Interlock Tests the interlock in the printer 
cover.

Failure of interlock mechanism. 
Faulty latch. 
Disconnected cables.

Cabin Temperature Tests the temperature level in the 
build‐tray area.

Faulty temperature sensor (OHDB).

Head EEPROM Tests the read/write capabilities of 
the print‐head driver cards.

Faulty print‐head driver card.

Head Voltage Checks the control of voltages 
supplied to the print heads.

Faulty print‐head driver card.

Tray Heater Not used for this printer —
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Replacing the 
Waste 
Container

The waste container contains partially cured polymeric material produced 
during normal operation and maintenance of the Eden printer. For safety 
and environmental reasons, this material is kept in a special leak‐proof, 
disposable container. 
The container has a capacity of 10 kilograms of waste material—usually 
enough for several months of printer use. The printer software displays a 
warning message when the container weighs 9 kilograms, and stops the 
printer when it weighs 9.5 kilograms. Above 9 kilograms, the software does 
not allow you to start a print job until you replace the waste container. You 
can monitor the weight of the waste container in the Maintenance screen of 
the printer interface. You can also visually inspect the level of waste in the 
container. (To access it, see page 48.)

To monitor the waste weight (and other indicators) in the Eden printer:
In the main printer interface screen, click the display toggle to view the 
Eden printer indicators.

Figure 7-3: Eden printer interface, showing waste weight (red background indicates 
operator alert)

Head/Block Heaters Tests the heaters in the print heads 
and in the print‐block body.

Faulty heaters or thermistors.

Axes Limit Tests the hardware and software 
limits of all axes.

Faulty hardware sensors. 
Wrong Max Position parameter.

Vacuum Tests the vacuum level in the print 
block.

Faulty vacuum sensor. 
Vacuum leakage. 
Wrong parameters.

Test Name Description Possible Reason for Failure

Waste weight

Display 
toggle button
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The waste container consists of a plastic container inside a cardboard box. 
You typically dispose of the entire waste container—including the box. 
Therefore, you must assemble a new box and insert a new plastic container 
before you can install it in the printer.

To prepare a new waste container:
1. Assemble the cardboard box, making sure to punch out the perforated 

sections.
2. Place a new plastic container into the box.

Note: Do not close the box until you connect the waste drain tube from the 
printer (see below).

To replace the waste container:
1. Locate the door on the lower‐left side of the Eden printer.
2. Push in the upper‐right corner of the door to release the latch and open 

the door.

Figure 7-4: Accessing the waste container

3. Carefully slide out the waste container, removing it from the printer.

Figure 7-5: Removing the waste container

4. Place the new waste container next to the full container.

Replacement boxes, plastic containers, and sealing caps are supplied in the 
Eden printer start-up and preventive-maintenance kits.
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5. Unscrew the cap securing the waste drain tube and connect it to the 
new container.

6. Close the full container with a sealing cap.
7. Close the new waste‐container box, using tape to hold it closed. 
8. Position the waste container under the Eden printer, on the load cells.

• The container should be on the extreme right side of the 
compartment. 

• Make sure that the waste drain tube is not crimped and that it is not 
pinched by the container.

9. Close the waste compartment door.

Dispose of the full waste container in accordance with environmental and 
safety requirements.
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Removing Models After Printing
After printing models, you should allow them to cool as much as possible 
before handling them. If additional models do not have to be produced on 
the Eden printer, it is best to let the printed models cool in the printer, with 
the cover closed, as long as possible. 

If the Eden printer must be used to produce additional models as soon 
as possible:
1. Let the printed models cool on the build tray for at least 10 minutes. 
2. Very carefully, remove the models from the tray with a scraper or 

spatula (supplied in the tool kit), taking care not to pry or bend the 
model.

3. Place the models on a flat surface, and cover them with a cardboard 
box or paper hood.
This allows the models to cool slowly and evenly.

4. Let the models cool for several hours.

Removing the Support Material
After printed models have cooled, the support material must be removed. 
This can be done by different methods, depending on the size of the model, 
how delicate it is, the amount and location of the support material, and 
other factors. Use the following methods as a guide, and adapt them (or a 
combination of them) for finishing the models you are handling.

Removing Excess Support Material by Hand
While wearing protective gloves, break away excess support material on 
the outside of the model. For delicate models, use a toothpick, pin or small 
brush after dipping the model in water.

Removing Support Material with Water Pressure
For most models, the most efficient way to remove support material is by 
using a high‐pressure water jet. One suitable system is the Balco WaterJet 
cleaning unit, shown in figure 8‐1 on page 8‐3. This device is marketed by 
Objet.

WARNING:  Wear protective gloves when handling printed models 
before they are washed.
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Figure 8-1: Balco WaterJet Cleaning Unit

To clean a model using this device, you place it in the chamber, and you 
manipulate it and the jet using the built‐in, waterproof sleeves. A pump 
turns ordinary tap water into a high‐pressure jet, and a wiper keeps the 
window clear.

Removing Support Material with Caustic Soda
Soak models in a 2‐percent solution of caustic soda (sodium hydroxide) to 
remove support material from difficult‐to‐reach areas and to give the 
model a smooth, clean finish. The amount of time you soak the model in the 
solution depends on how delicate it is and how much support material 
needs to be removed, but it is typically between half‐an‐hour and several 
hours. In any case, you should remove as much support material as 
possible before the caustic soda treatment, and rinse the model thoroughly 
(with a water jet) afterwards. 

Storing Models
Models are cured as they are printed, making them safe and stable for a 
long time. However, proper storage conditions are necessary to prevent 
deforming.
• Keep printed models at room temperature and in a low‐humidity 

environment.
• Do not expose models to direct sunlight and other heat sources.

Use caution when cleaning delicate models with high-pressure water 
systems.

WARNING:  Caustic soda may cause chemical burns, scarring and 
blindness. Mixing it with water generates heat that could ignite other 
materials.Take adequate safety precautions; always use nitrile gloves 
when handling caustic soda and models soaked in it.
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